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فصل  اول
: 

 ررسی نقشه معماری:ب

با توجه به نقشه طراحی شده توسط مهندس معمار باید مهندس محاسب یک بررسی کلی داشته باشد.برای مثال نحوه ستون گذاری 

ستون احاطه شده باشد در بخش بعدی در مورد ستون گذاری صحبت خواهیم کرد و همچنین جانمایی راه پله که باید توسط چهار 
و هم چنین نقشه معماری طوری باشد که مهندس محاسب بتواند یک سیستم سازه ای  مناسب برای سازه در نظر بگیرد تا در هنگام 

 کنترل سازه دچار مشکل جواب ندادن دریفت ومشکلات دیگر نشود.

 

 

 

 

 راه پله

 آسانسور

 بتنی دال
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 جزئیات معماری:

 سانتی متر 02 ضخامت دیوار های پیرامون

 سانتی متر 02 ضخامت دیوار های تیغه بندی

 سانتی متر 2.0 ارتفاع طبقات مسکونی)از کف تا کف(

 سانتی متر 0.2 )از کف تا کف(ارتفاع پیلوت

 سانتی متر 0.2 )از کف تا کف(ارتفاع خرپشته

 متر 02.2 های تیغه بندی  در طبقه)مسکونی( طول دیوار

 متر 2 طول دیوار های تیغه بندی  در پیلوت

 سانتی متر 22 تیرچه بلوک ضخامت سقف

 سانتی متر 02 ضخامت دال بتنی

 

 .در اتفاع طبقات ضخامت سقف منظور شده است 

  متر مربع  میباشد. ساختمان مورد نظر از سمت شرق و غرب خود به ساختمان همسایه محدود  002مساحت هر طبقه
 می شود. از سمت شمال و جنوب به گذرگاه مشرف است. 

   انتخاب مصالح فلزی یا بتنی:

 عامل هایی که باعث انتخاب مصالح فلزی یا بتنی هستند عبارتنداز:

 ا در برابر نیر وهای واردهایمنی و پایداری آن ه (0
 نحوه اجرا (0
 از لحاظ اقتصادی مقرون به صرفه بودن (2

اول باید گفت که هر دو مصالح ایمنی و پایداری لازم را به نسبت مساوی دارند ولی دو مورد آخر می تواند معیار گزینه در مورد 

ممکن  در هر جاییواد تهیه بتن مثل شن و ماسه و... دسترسی به ماین که مناسبی برای انتخاب نوع مصالح باشد.حالا با توجه به 
است پس از لحاظ اقتصادی مقرون به صرفه تر می باشد وهم چنین سرمایه اولیه کمتری نسبت به فولاد میخواهد زیرا با توجه به 

 جا تهیه کرد.پیشرفت کار در سازه بتنی سرمایه به پروژه تزریق می شود ولی در سازه فلزی باید آهن الات رو باید یک

هر دو سازه فلزی و بتنی به افراد اجرایی ماهر نیاز دارد و هم چنین نوع منطقه از لحاظ افراد متخصص در اجرای سازه بتنی وفلزی 
 می تواند در انتخاب مصالح تاثیر گذار باشد .

اشغال میکند ولی در سازه های فلزی یکی از ایراد های مهم سازه بتنی طراحی ابعاد ستون های بزرگ که فضای مفید ساختمان را 
 این مشکل وجود ندارد. ولی به هر حال در این پروژه از مصالح بتنی برای ساخت سازه استفاده خواهیم کرد

 کنترل فاصله ستون ها:

فاصله ستون ها ازهم در حد قابل قبول باشد. اگر فاصله ستون ها کمتر باشد فضای از سازه را اشغال کرده و هم چنین  (0
. چرا سایز وزن سازه را بیشتر میکند که موجب می شود تیر ها در دهانه خیلی کوچک جواب نداده و بزرگ طراحی شوند

 تیر ها بزرگ می شود؟
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متر فاصله ستون ها رو افزایش داد. آیا  2متر می باشد. ولی در صورت لازم می توان تا حداکثر  6تا  4فواصل معقول بین  (0

 متر در نظر گرفت؟ 2بیش از می توان فاصله ستون ها 
چهار طرف راه پله باید ستون گذاری شودو اگر آسانسور وجود دارد حدالامکان ستون در هر طرف آن باشد ولی به هر  (2

حال حالت های خاصی وجود دارد که امکان ستون گذاری نیست که در پروژهایی که کار خواهیم کرد توضیح داده می 
 شود.

 زی به اجرای طره باشد باید سعی شود تیر طره به ستون متصل شود.اگر در جای از سازه نیا (4
مهندس معمار با مشورت با مهندس محاسب سعی کند که ستون ها در یک امتداد باشند.درجا هایی که شکستگی در سازه  (2

 است سعی شود ستونی درآن جا در نظر گرفته شود.

 انتخاب محل مناسب برای دیوار برشی:

سعی بر آن است که مطالب پایه را اول آموزش بدهیم از دیوار برشی استفاده نخواهیم کرد و سیستم سازه را  چون در پروژه اول
 قاب خمشی متوسط در نظر می گیریم.

 در پروژه دوم به صورت مفصل از جانمایی و طراحی دیوار برشی صحبت خواهیم کرد.

 :)بارهای جانبی + ثقلی(انتخاب نوع سیستم سازه ای

 ل اینکه مصالح سازه ما بتنی است پس ما می توانیم از این سیستم های سازه ای زیر استفاده کنیم:به دلی

 قاب خمشی بتن مسلح معمولی (0
 قاب خمشی بتن مسلح متوسط (0
 قاب خمشی بتن مسلح ویژه (2
 قاب خمشی بتن مسلح متوسط + دیوار برشی بتن مسلح متوسط (4

 مسلح ویژهقاب خمشی بتن مسلح متوسط + دیوار برشی بتن  (2
 قاب خمشی بتن مسلح ویژه + دیوار برشی بتن مسلح ویژه (6

معمولی را نمی توان برای سازه های  بتن مسلح هر یک از این سیستم ها محدودیت خاص خود را دارد مثلا برای مثال قاب خمشی
یلی زیاد و زیاد در تمام مناطق لرزه ساختمان هایی با اهمیت خمتر است استفاده کرد و هم چنین برای  02که ارتفاع آن ها بیش از 

 مجاز نمی باشد. 0و 0با اهمیت متوسط در مناطق لرزه خیزی  یختمان هایاخیزی و برای س

برای اطلاع بیشتر از نوع سیستم های سازه ای  و محدودیت های از لحاظ ارتفاع و نوع لرزه خیزی  هر کدام از آن ها می توانید به 
 ویرایش چهارم مراجعه کنید. 0222( آیین نامه 4-2جدول )

 22متوسط در نظر می گیریم که حداکثر می توانیم تا ارتفاع بتن مسلح پس ما برای این پروژه نوع سیستم سازه ای را قاب خمشی 
 .کنیممی متر از این سیستم استفاده 

ناحیه ویژه دوانتهای ستون ها نباید از محدودیت قاب خمشی بتن مسلح متوسط: در این سازه ها فاصله خاموت ها از یکدیگردر 
 سانتی متر بیشتر باشد. 02

 در پروژه های بعدی در مورد سیستم های دیگر مفصل صحبت خواهیم کرد.
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 انتخاب نوع سقف:

ازه ون بیشترین جرم سچتحمل بار های ثقلی)مرده و زنده( وانتقال آن به تیر و ستون یکی از وظایف سقف ساختمانی می باشد. 
در سقف است باید از لحاظ دیافراگمی عملکرد مناسبی داشته باشد تا نیروهای جانبی وارد به سازه را به طور کامل به اعضای باربر 

 :متداولانواع سقف های . برساند

 سقف تیرچه بلوک (1

 دال یکرفه (1

 دال دو طرفه (1

 سقف تیرچه کرومیت (1

 سقف کامپوزیت ساده (1

 سقف عرشه فولادی (6

سقف تیرچه بلوک استفاده می کنیم که در قسمت طراحی دستی روش طراحی این نوع سقف ها حالا ما برای سقف سازه از 
 در ضمن جلوی آسانسور قسمتی وجود دارد که به صورت دال طراحی می شود. به صورت جامع گفته شده است.

 درز اتقطاع:

است بهساختمان مجاور آسیب برساند  به دلیل اینکه در هنگام زلزه ساختمان مورد نظر دچار ارتعاشاتی می شود که ممکن
موضوع درز انقطاع را  4ویرایش  0222برای جلوگیری از برخورد ساختمان  موردنظر با ساختمان همسایه مجاور آیین نامه 

 داریم: 4ویرایش  0222( آیین نامه 0-4-0مطرح می کند که مطابق بند)

 

آن  0.005Hطبقه یا کمتر )با اهمیت کم یا متوسط(فاصله هر طبقه از مرز زمین مجاور باید حداقل برابر  2برای ساختمان  (1

تا  022سری عمران م صفحات  0222. برای مطالعه بیشتر به کتاب زیر ذربین آیین نامه طبقه از روی تراز پایه باشد

 .مراجعه شود022

 

طبقه )با اهمیت کم یا متوسط ( و یا ساختمان هایی با اهمیت خیلی زیاد و زیاد حداقل  2برای ساختمان هایی بیش از  (0
 مقدار تغییر مکان جانبی غیر خطی در آن طبقه باشد. 02فاصله ی هر طبقه ی ساختمان از زمین مجاور باید برابر %

 

 تراز طبقه: 

می توان گفت که تراز پایه ، به ترازی در ساختمان اطلاق می شود که در هنگام  4ویرایش  0222چهارم استاندارد با توجه به ویرایش 
 زلزه از آن تراز به پایین حرکتی جانبی بین ساختمان و زمین نداشته باشد.

 

 و توزیع بار به صورت یکطرفه استدر سازه های فولادی کاربرد دارد 

 

 است در سازه های بتنی کاربرد دارد و توزیع بار به صورت یکطرفه

 است طرفهدودر سازه های بتنی کاربرد دارد و توزیع بار به صورت 

 cm 8 = 15.6 * 0.005= درز انقطاع  
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 .توجه کنید شکل هابرای درک بیشتر موضوع به این 

 

 

 

 

 

 

 

( به خاطر اینکه هیچ گونه عاملی)مثل دیوار حائل( از حرکت جانبی ساختمان جلوگیری نمی کند پس تراز پایه 0-0در شکل) (0

دیوار    Bتا   Aخواهد بود و در ضمن اگر ازتقطه   Aحساب کرد در این صورت تراز پایه ما تراز  Bرا نمی توان از تراز 
در نظر بگیریم و در صورت خاک سست باید تراز پایه از  Bحائل و خاک متراکم بود می توانستیم تراز پایه را از نقطه 

 .نظر گرفته شود در Aنقطه 
 در نظر گرفته می شود که توضیحات آن روی شکل داده شده است. B( تراز پایه از تراز 0-2در شکل ) (0

ول به دلیل اینکه زیرزمین  در نقشه نیست و هم چنین دیوار حائلی در نظر گرفته نشده است پس تراز در هر صورت در پروژه ا

 .خواهد بود پایه از کف طبقه پیلوت تا پشت بام

 

 1-1شکل 

 1-1شکل 1-1شکل  

 Bتراز 

 

 Aتراز 

 

 Bتراز 
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 مشخصات کلی پروژه:

 شهر اردبیل محل احداث ساختمان

 سقف 2 تعداد طبقات

 2گروه  نوع زمین

 متوسطقاب خمشی   Xسیستم باربر جانبی در جهت

 قاب خمشی متوسط Yسیستم باربر جانبی در جهت

2 تنش مجاز خاک
𝐾𝑔

𝑐𝑚2
 

 تیرچه بلوکسقف  نوع سقف
 

 آموزش بارگذاری سازه:

 بار مرده:

 شامل وزن دائمی ساختمان مانند کف ها)سقف ها( ، دیوار های پیرامون و دیوار های تیغه بندی و همچنین تاسسیات آب وفاضلاب 
 و دیوارها شامل می شود. قسمت اعظم بارهای مرده در ساختمان را سقف ها و تهویه و...

  :طبقاتمحاسبه بار مرده سقف 

 

 

لح مصا ع   (2kg/mشدت بار) وزن مخصوص ضخامت نو

 67.5 2250 0.03 موزائیک

 42 2100 0.02 ملات ماسه وسیمان

 30 600 0.05 پوکه ریزی

 250 2500 0.05 بتن 

 جزئیات سقف طبقات
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 110=10×11 ------- ------ بلوک سیمانی
 24 1600 0.015 گچ کاری

 6.5 1300 0.005 سفید کاری
 2kg/m 035  جمع کل:

 محاسبه بار مرده سقف پشت بام:

 

 

 

 

 

 

 

 

لح مصا ع   (2kg/mشدت بار) وزن مخصوص ضخامت نو

 51 ------ ------ ایزوگام

 42 2100 0.02 ملات ماسه وسیمان

 06 600 0.1 پوکه ریزی

 250 2500 0.05 بتن 

 110=10×11 ------- ------ بلوک سیمانی
 24 1600 0.015 گچ کاری

 6.5 1300 0.005 سفید کاری
  1652kg/m جمع کل:

 پشت بامجزئیات سقف 
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 :(نما بدون)سانتی05 پیرامون دیوار جزئیات

 

 

ع  لحنو  (2kg/mشدت بار) وزن مخصوص ضخامت مصا

 170 850 0.2 آجرکاری 

 24 1600 0.015 گچ کاری

 13 1300 0.01 سفید کاری

 21 2100 0.01 سیمان کاری در یک طرف
  2252kg/m جمع کل:

 

 

 

 

 

 

 سانتی)بدون نما(02دیوار پیرامون جزئیات 
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 :(نمادار)سانتی05 پیرامون دیوار جزئیات

 

 

 

 

 با اعمال ضریب بازشو داریم:نکته:  

ع  لحنو  (2kg/mشدت بار) وزن مخصوص ضخامت مصا

 170 850 0.2 آجرکاری 

 24   1600 0.015 گچ کاری

 13   1300 0.01 سفید کاری

 42 2100 0.02 ملات ماسه وسیمان

 56 2800 0.02 سنگ گرانیت
  5612kg/m جمع کل:

 سانتی)نمادار(02دیوار پیرامون جزئیات 

2kg/m =2140.7×305 
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 :جان پناهدیوار جزئیات 

 

             

 

 

 

 

 

 سانتی)پارتیشن(:05دیوار جزئیات 

 

لح مصا ع   (2kg/mشدت بار) وزن مخصوص ضخامت نو

 576 516 6.2 آجرکاری 

 25 5066 6.65 سیمان کاری

 22 2566 6.62 ملات ماسه وسیمان

 10 2566 6.62 سنگ گرانیت
  2962kg/m جمع کل:

 دیوار جان پناهجزئیات 
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کمتر باشد می توانیم  kg/m2 200(:چناچه وزن هر متر مربع سطح دیوار های جدا کننده از 20)مبحث ششم ویرایش 6-5-2-2بند
آن را به عنوان بار زنده به صورت گسترده در کف طبقات پخش کنیم در غیر این صورت آن را به عنوان بار مرده در محل واقعی آن 

 باشد نیازی به بار تیغه بندی نیست.  kg/m2 400بیش از  و هر جایی که با زنده آن در نظر می گیریم.

 محاسبه بار معادل تیغه بندی:

 طبقه طول پارتیشن ارتفاع مساحت

 120 𝑚2 2.8 – 0.3 =2.5 m 5 m پارکینگ 

120 𝑚2 3.2 – 0.3 =2.9 m 23.5 m طبقات 

 

 

لح مصا ع   (2kg/mشدت بار) وزن مخصوص ضخامت نو

 51 516 6.5 آجرکاری 

 25 5066 6.651 گچ کاری از دو طرف

 20 5566 6.65 سفید کاری از دو طرف
  5062kg/m جمع کل:

 سانتی)پارتیشن( بندی((02دیوار جزئیات 

=پارکینگ
5×2.5×160

120
= 16.67  

5-2-5-6 
 100

2kg/m 

 6مبحث  6-5-2-5 بند طبق
 100

2kg/m 
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 پله:جزئیات 

 

 

 

 

 

 

 

 

 

 

 

 بار زنده:

مراجعه کنید. رایج ترین آن ها در جدول زیر آمده  20( مبحث ششم ویرایش 0-2-6به جدول ) برای محاسبه بار زنده می توانید
 است:

 2kg/m  برحسب  بار زنده

لح مصا ع  د وزن مخصوص ضخامت نو  (2kg/mشدت بار) تعدا

 81 1 2700 6.65 سنگ مرم

 24 1/0.3 2400 0.003=0.02×0.15 سنگ تراورتن پیشانی

 127.5 1/0.3 1700 0.0225 آجرکاری
 cos31 282.8/1 2500 0.1 بتن رمپ

 cos31 37.33/1 1600 0.02 اندود گچ وخاک
 cos31 15.16/1 1300 0.01 اندود گچ رویه

 2kg/m 570  جمع کل:

 پله  جزئیات

5-2-5-6 
 100

2kg/m 

5-2-5-6 

=طبقات
23.5×2.9×160

120
= 90.87   100

2kg/m 

 6مبحث  6-5-2-5 بند طبق
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 112 بام های تخت وشیب دار و قوسی

 122 سالن غذاخوری و رستوران ها

 برابر بار زنده متصل به آن1.1  بالکن ها

 122 راه پله ، راهروها

 122 خصوصی اتاق ها وسایر فضای

 622 انباری های سبک

 1122 انباری های سنگین

 1122 آسانسور

 712 موتورخانه

 122 کیلونیوتن 12محل عبور وپارک خودروهایی با وزن حداکثر 

 622 کیلونیوتن 92تا  12محل عبور وپارک خودروهایی با وزن حداکثر  

 

 بار برف:

 

𝑃𝑔 =)منطقه برف سنگین =بار برف مبنا)شهر اردبیل 

𝑷𝒈 = 𝟐𝟎𝟎𝐤𝐠/𝐦𝟐 

 

     ℎ𝑝 = 𝑃𝑟/𝛾  

 

 به شرح زیر می باشد. 𝑝𝑟در فرض اولیه مقدار   4.0مقدار فوق از حداکثر مبحث ششم که برابر با 

𝒑𝒓 = 0.7 × 1 × 1 × 1 × 200 = 1.4𝐾𝑁/m2 

 در نهایت مقدار ارتفاع برف متوازن برابر است با:

ℎ𝑝 =
1.4

3.06
= 0.457𝑚 

عدد بدست آمده چون از ارتفاع جان پناه کم تر است پس نمی تواند در گروه برف ریز باشد هم چنین فرض شده ساختمان باند تر 
 لذا بام نمی تواند در گروه برف گیر قرار بگیرید در نهایت بام را نیمه برف گیر تلقی می شود.از ساختمان های اطراف است 

 ساختمان های شهری جزوه گروه ناهمواری زیاد می باشند پس داریم : 6-7-4-1مطابق بند 

𝐼𝑠 =ضریب اهمیت  (𝐼𝑠 = 1) 

 

𝑃𝑟 = 0.7 × 𝐶𝑠 × 𝐶𝑡 × 𝐶𝑒 × 𝐼𝑠 × 

𝑃𝑔 

 

 

 

 
 

 

 

𝛾 = 0.43𝑝𝑟 + 2.2 = 0.43 × 2 + 2.2 γ = 3.06kg/m2 
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𝐶𝑒          6-7-2طبق جدول  = 𝐶𝑡          6-7-3طبق جدول        1 = 𝐶𝑠          6-7-6طبق جدول          1 = 1   

𝒑𝒓 = 0.7 × 1 × 1 × 1 × 200 = 140 𝑘𝑔/m2 

 در این جا بار زنده بام از بار برف بیش تر می باشد پس بار زنده بام را در محاسبات در نظر می گیریم.

 خلاصه بارگذاری:

) (2kg/mبار مرده سطحی) موقعیت   بار معادل تیغه بندی (2kg/m) بار زنده (kg/mبار مرده خطی

 ---- 150 ---- 165 بام
 100 200 ---- 156 طبقه مسکونی

 ---- 500 ---- 176 پله
 ---- ---- 662=2.9×228 ---- دیوار جانبی بدون نما

 ---- ---- 621=2.9×214 ---- دیوار جانبی با نما

 ---- ---- 174=0.6×228 ---- دیوار جان پناه

 100 300 ----- ---- پارکینگ
 

 :بررسی نامنظمی سازه 

 انواع نامنظمی :

 ( نامنظمی در ارتفاع0( نامنظمی در پلان             0 

 نامنظمی در پلان:

 نامنظمی هندسی (0
 نامنظمی پیچشی (0
 نامنظمی دیافراگمی (2
 نامنظمی خارج از صفحه (4
 نامنظمی سیستم های موازی (2

 برداشت شده است( 4ویرایش  0222توضیحات کلی درباره ی نامنظمی ها در پلان ساختمان_ مستقیم از آیین نامه 

 

 (:0022آیین نامه  1-7-1نامنظمی در پلان)طبق بند 

 نامنظمی هندسی

درصد طول پلان در آن  12از گوشه های ساختمان بیش تر از در مواردی که پس رفتگی همزمان در دو جهت در یکی 

 جهت باشد.
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 نامنظمی پیچشی:

تهای ساختمان در هر طبقه ، با احتساب پیچش تصادفی و با منظور در مواردی که حداکثر تغییر مکان نسبی در یک ان

𝐴𝑗کردن  = درصد متوسط تغییر مکان نسبی در دو انتهای ساختمان در آن طبقه باشد. دراین موارد  12بیش از  1

های در صد باشد نامنظمی )شدید( توصیف می شود. نامنظمی  12نامنظمی )زیاد( و مواردی که این اختلاف بیشتر از 

 پیچشی تنها در مواردی که دیافراگم های کف ها صلب و یا نیمه صلب هستند کاربرد پیدا می کند.

 

 نامنظمی در دیافراگم:

درصد سطح طبقه،و با  12درمواردی که تغییر ناگهانی در مساحت دیافراگم ، به میزان مجموع سطوح بازشوی بیشتر از 

 درصد سختی طبقات مجاور ، وجود داشته باشد. 12ان بیشتر از تغییر ناگهانی در سختی دیافراگم ، به میز

 

 نامنظمی خارج از صفحه:

در مواردی که در سیستم باربر جانبی انقطاعی در مسیر انتقال نیروی جانبی ، مانند تغییر صفحه ، حداقل در یکی از 

 اجزای باربر جانبی در طبقات وجود داشته باشد.

 

 نامنظمی سیستم های موازی:

 در مواردی که بعضی اجزای قائم باربر جانبی به موازات محورهای متعامد اصلی ساختمان نباشد.
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 (:0022آیین نامه  0-7-1نامنظمی در ارتفاع)طبق بند 

 نامنظمی هندسی:

 درصد آن در طبقات مجاور باشد. 112در مواردی که ابعاد افقی سیستم های باربر جانبیدر هر طبقهبیش تر از 

 

 نامنظمی جرمی:

 درصد با جرم های طبقات مجاور تفاوت داشته باشد. 12درمواردی که جرم هر طبقه بیشتر از 

 طبقات بام وخرپشته از این تعریف استثنا هستند.

 

 نامنظمی قطع سیستم باربر جانبی:

ی طبقه روی خود کمتر باشد ، چنین طبقه ای اصطلاحا درصد مقاومت جانب 82در مواردی که مقاومت جانبی طبقه از 

درصد کاهش پیدا کند باید طبقه اصطلاحا )طبقه خیلی  61)طبقه ضعیف ( نامیده می شود. در مواردی که مقدار فوق به 

 ضعیف( توصیف می شود.

 

 نامنظمی سختی جانبی:

درصد متوسط  82قه روی خود و یا کم تر از درصد سختی جانبی طب 72در مواردی که سختی جانبی هر طبقه کم تر از 

 طبقه روی خود باشد .چنین طبقه ای اصطلاحا )طبقه نرم( نامیده می شود. 1سختی های جانبی 

درصد کاهش پیدا کند، طبقه اصطلاحا )طبقه خیلی نرم ( توصیف  72درصد و  62در مواردی که مقادیر فوق به ترتیب به 

 می شود.
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 ساختمان های نامنظم:محدودیت در احداث 

 : 4ویرایش  0222( آیین نامه 2-0-0مطابق بند )

 روش های تحلیل سازه :

می توانیم یکی از آن  4ویرایش  0222تحلیل سازه روش های مختلف وجود دارد که با توجه به شرایط ذکر شده در آیین نامه  برای
 ها را انتخاب کنیم. انواع روش های تحلیل سازه:

 روش تحلیل خطی (1

 

 

 روش تحلیل غیر خطی (1

 

 در این پروژه از روش تحلیل خطی استاتیکی استفاده می کنیم.

 محدودیت های روش تحلیل خطی استاتیکی:

 نامنظم(طبقه( مجاز نیست) در هر دو حالت منظم و  02متر از تراز پایه ) 22این روش در ساختمان های با ارتفاع بیش از  (0
 

متر ، در صصورتی که ساختمان دارای نامنظمی در پلان از نوع )  22طبقه و با ارتفاع کمتر از  2در پلان های نمنظم بیش از  (0
 زیاد و شدید پیچشی(و یا منظمی در ارتفاع از نوع )جرمی( یا طبقه نرم یا خیلی نرم نباشد میتوان استفاد کرد

 امیکی تاریخچه ی زمانی برای استفاده در همه انواع سازه ها روش مناسبی می باشد.نکته: روش های دینامیکی طیفی و دین

در روش تحلیل استاتیکی معادل  محاسبه برش پایه را در اینجا انجام داد ولی توزیع برش پایه در ارتفاع و توزیع نیرو در پلان 
 داده شده است. سازه در جزوه آموزش تحلیل و طراحی دستی که در حال نگارش است توضیح

 

 تحلیل استاتیکی 

 تحلیل دینامیکی 
 تحلیل طیفی 

 تحلیل تاریخچه زمانی 

 ی  طتحلیل استاتیکی غیر خ

 تحلیل تاریخچه زمانی غیر خطی
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 :زلزله ضریب محاسبه

 ر جانبی)قاب خمشی متوسط( می باشد پس داریم : نوع سیستم با یکطر اینکه سازه در دو جهت متعامد دارای ابه خ

𝐶𝑦  =𝐶𝑥 

                

 

 است. 2.2ا شهر اردبیل  در پهنه با خطر نسبی زیاد قرار دارد پس نسبت شتاب مبنای طرح  0222آیین نامه  0با توجه به پیوست  

ناوب نیاز داریم چون زمان تسازه)زمان رفت وبرگشت سازه(  اصلی تناوببرای بدست آوردن ضریب بازتاب به زمان با توجه به اینکه ما 
( آیین نامه 2-2-2کنیم که با توجه بند ) تحلیلی صورت نگرفته است باید از زمان تناوب تجربی استفاده زیرا را در اختیار نداریم اصلی 
 داریم:در این اینجا فرض بر این است که جداگر ها به عنوان میانقاب عمل نمی کنند. 0222

 

 

 

 :ویرایش چهارم داریم 0222( آئین نامه 3-3-3-1طبق بند)

 

T 𝑅𝑢 I B A 
 نسبت شتاب مبنای طرح ضریب بازتاب اهمیت ساختمان ضریب رفتار ساختمان زمان تناوب
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       T=0.05H0.9=0.05× 15.6
0.9
T= 0.59 

       T=1.25× 0.59 = 𝟎. 𝟕𝟒 

 

 

I=1             A=0.3            T=0.74         𝑇𝑠=0.7              𝑇0=0.15              𝑆0=1.1              S=1.75      

 

 

 

درصد افزایش  02( می توان زمان تناوب تجربی را (3-3-3-1بر مبنای تبصره بند 

 ب تحلیلی از این مقدار بیشتر باشداو داد به شرطی که زمان تن

𝑁 = (
0.7

4 − 𝑇𝑠
) × ( 𝑇 − 𝑇𝑠) + 1 => 𝑁 = 1.008 
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T 𝑅𝑢 I B A 𝐶𝑑 Ω 

0.74 5 1 2.62 0.3 4 3 
 

 

 

 

 

 

1.008 ==>B = 2.62 × =2.601 × 𝑵 𝑩𝟏 B= 

 

C=
𝐴×B×I

𝑅𝑢
= 0.1572 

0.5T+0.75 ==> K=1.12 K= 

𝐵1=(S+1)( 𝑇𝑠/𝑇) =2.601 
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 میزان درصد مشارکت بار مرده وزنده در تعیین وزن لرزه ای سازه:

 

چون ما در این پروژه وزن لرزهای سازه را به صورت دستی پیدا نکردیم پس نمی توانیم برش پایه بدست بیاوریم و این کار 

یک پارامتری با عنوان نیروی  0222بر عهده ی نرم افزار می گذاریم . به عنوان یک نکته آیین نامه ای قبلا در ویرایش سوم 
رفته است که توزیع   Kنیروی شلاقی حذف شده به جای آن ارتفاع طبقه را به توان  0222شلاقی بود که در آیین نامه جدید 

 بار جانبی را به صورت غیر خطی میکند که به واقعیت نزدیک تر باشد.

 برای درک بهتر توزیع نیروی زلزله به جزوه ی تحلیل و طراحی دستی که به زودی منتشر می شود مراجعه شود .

  V=CWساختمان:  فرمول برش پایه کل 

ما نمی توانیم بار باد وزلزله را همزمان وارد کنیم و چون وزن سازه بیشتز از سطح ان است پس بار  0222طبق آیین نامه 

 زلزله غالب است. در پروژه سوم نحوه ی محاسبه بار باد مطابق آیین نامه جدید توضیح داده شده است.
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 فصل دوم:

 : تعریف خطوط شبکه 

 بعد از اجرا شدن نرم افزار محیطی همانند شکل زیر ظاهر می شود: را اجرا می کنیم ETABS 2015ابتدا نرم افزار 

 

 

 مسیر زیر را دنبال می کنیم: 0202برای ایجاد یک پروژه یا مدل جدید در ایتبس 

 

 

پنجره در شکل موجود بر روی  های بر روی صفحه نمایش ظاهر می شود که گزینه (0-0) بعد از اجرای این دستور شکل

 توضیح داده شده است: (0-0)

 

 

 ETABS 2015نمایی از نرم افزار  1-1شکل 

 File > NewModel …  (Ctrl + N)  منوی
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 ( استفاده از پیش فرض هایی که کاربر قبلا به نرم افزار تعریف کرده است.0شماره 

 می توانیم از اطلاعات موجود در پروژه های که قبلا  کار کرده ایم استفاده کنیم ( با انتخاب این گزینه ، 0شماره 

 Display( با  انتخاب این گزینه، گزینه هایی که در شکل بالا می بینید غیر فعال هستند فعال می شود. مثل )2شماره 
Units) 

را که  2اینکه ما پروژه اول را کار می کنیم و از قبل پروژه ای در نرم افزار کار نکرده ایم ابتدا باید گزینه شماره  ربه خاط

(Use Buit-in Settings With ( را انتخاب کنیم. مانند شکل )0-2) تنظمیات را انجام می دهیم 

 

 

باز می شود که در این پنجره باید تعداد ستون ها و  New Model Quick Templatesرا زده و پنچره ی  OKبعد دکمه 

 (0-4تعداد طبقات و ارتفاع طبقات درج گردد. مانند شکل )فاصله ی آن ها و همچنین 

 1-1شکل 

1 

1 

1 

 

 طع فولادیاطلاعات مقا

 اندازه گیری انتخاب واحد

 

0 

0 

3 

 1-1شکل 

 طراحی بتنانتخاب آیین نامه 

 فولاد طراحی انتخاب آیین نامه
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 Grid Dimensions (plan): توضیحاتی در مورد کادر

Number of Grid Lines in X Direction ی موجود در جهت تعداد ستون هاX 

Number of Grid Lines in Y Direction  تعداد ستون های موجود در جهتY 

Spacing of Grid in X Direction  فاصله آکس به آکس ستون ها در جهتX 

Spacing of Grid in Y Direction  فاصله آکس به آکس ستون ها در جهتY 
استفاده کنیمو  Custom Grid Spacingبه دلیل اینکه در این پروژه فاصله آکس به آکس ستون ها یکسان نیست باید از گزینه  

استفاده   Specify Grid Labeling Optionsباید از گزینه همچنین برای اینکه شماره آکس ستون ها با نقشه معماری یکسان باشد 
 (0-2کرد همانند شکل )

 

 

 

 

 

 

 

ظاهر شود و سپس با کلیک بر روی   …Edit Grid Dataانتخاب کرده تا دکمه  Custom Grid Spacing سپس با استفاده گزینه
 ( 0-6ظاهر شود.شکل)  Grid System Dataآن پنجره 

 Display Grid Dataه برای اینکه فاصله ستون ها به صورت آکس به آکس باشد حتما باید گزین Grid System Dataکه در پنجره 

as Spacing   (  انجام می دهیم.0-6. بقیه تنظیمات مطابق شکل )فعال شود 

 

 1-1شکل 

 

 1-1شکل 
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در شکل بالا گزینه های دیگریی وجود را می زنیم. OKدکمه  Yو  Xبعد از تعریف خطوط شبکه آکس به آکس ستون در دو جهت 

مراجعه کنید که از توضیحات آن در این کتاب   ETABS 2015دارد که برای آشنایی بیشتر می توانید از جزوه مدل سازی پیشرفته در 
 صرف نظر می کنیم و هم چنین برای درک بیشتر تعریف خطوط آکس بندی ستون ها می توانید از فیلم آموزشی نیز استفاده کنید.

چنین ارتفاع  باز می گردیم تا تعداد طبقات و هم New Model Quick Templatesرا زدیم به پنجره  OKبعد از اینکه دکمه  
( توجه کنید همانند شکل 0-0را فعال کنیم به شکل ) Simple Story Dataبرای این کار باید گزینه   طبقات را مشخص کنیم

 زیر گزینه ها را ویرایش می کنیم.

 

 

 

 

 

 

 

 
 

 1-7شکل 

 طبقات + خرپشتهتعداد 
 ارتفاع طبقات

 ارتفاع طبقه پیلوت

 برای اصلاح ارتفاع طبقات و خرپشته باید فعال باشد

 

 1-6شکل 

برای وارد کردن فاصله 
 ها آکس به آکس ستون

http://www.omraniha.com


 نویسنده:سعید مرتضوی                                                                ETABS2015 آموزش نرم افزار

 Edit Storyرا فعال کرده و سپس روی دکمه  Custom Story Dataبرای اینکه  ارتفاع بعضی از طبقات را اصلاح کنیم باید گزینه 
Data  کلیک می کنیم  تا پنجرهStory Data ( ارتفاع طبقات را اصلاح می کنیم.0-2باز شود مطابق شکل ) 

 

 

 

 

 

 

 

 

Story نام طبقه 
Height ارتفاع طبقه 

Elevation ارتفاع طبقه از کف زمین 
Master Story خواهیم کرد( طبقه مبنا )که در مدل سازی از این استفاده 

 New Model Quick Templatesرا فشار می دهیم و سپس در پنجره  OKبقیه گزینه ها نیازی به توضیح ندارند. بعد دکمه 
 ( مدل اولیه در ایتبس ظاهر می شود.0-2را می زنیم  همانند شکل) OKدکمه 

 

 

 

 

 

 

 

 

 

 

 

 
 1-8شکل 

استفاده از 

ورق  وصله 

 در ستون ها

ارتفاع  ورق  

وصله در 

 ستون ها

 

 1-9شکل 
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 الان در شکل بالا زمینه به صورت سیاه رنگ می باشد برای اینکار باید مسیر زیر را دنبال کنید.

 

 Black Backgronرا به  Screenگزینه Type   For Deviceنشان داده می شود که باید درکادر  Set Display Colorسپس پنجره 

 تغییر می دهیم.

 تنظیمات مربوط به واحد اندازه گیری:

رم ن برای اینکه یک واحد کلی داشته باشیم و همه ی واحد ها براساس آن به نرم افزار معرفی گردد در پایین و سمت راست گوشه

باز شده  را انتخاب می کنیم در پنجره Consistent Unitsمی کنیم و سپس از منوی باز شده گزینه  را انتخاب  افزار             
 ( تغییر می دهیم.0-02رو مطابق شکل ) گزینه ها

 

 

 

 

 تعریف مصالح:

ستفاده اآن ها  ازطراحی سازه ت مصالحی که در سازه به کار می رود را به نرم افزار معرفی کنیم تا نرم افزار در آنالیز و باید مشخصا
 مسیر تعریف مصالح: کند.

 : C21تعریف بتن 

 داریم: (0-00باز شده و مطابق شکل )  Define Materialاز اجرای این دستور پنجره ی بعد 

 

 

 

 

 

 

 

Options > Graphics Color > Display 

 

 

 1-11شکل 

 (mواحد طول )

 (kgنیرو  ) واحد

 (c)واحد حرارت 

  … Define > Material Properties  منوی

 

 تعریف مصالح جدید

 بتنیتعریف مصالح 

 کپی از مصالح تعریف شده

 دهش تغییرات در مصالح تعریف

 حذف مصالح 

 فولادیتعریف مصالح 

 میلگردتعریف 
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M 250جرم واحد حجم ، 
𝑘𝑔

𝑚2  

W 2500وزن واحد حجم ، 
𝑘𝑔

𝑐𝑚2
 

E 2.49𝐸9 مدول الاستیسیته ،
𝑘𝑔

𝑚2
 

 0.2 ضریب پواسون

 𝑓𝑐 21𝐸5مقاومت فشاری 
𝑘𝑔

𝑚2
 

 

 

 

 

 Material Property و در پنجره کلیک می کنیم راModify /Show Materialگزینه ی سپس و  انتخاب کرده Psi 4000 گزینه
Data  مصالحی با نامC21  دهیم:تغییرات را انجام می  (0-00مطابق شکل )تعریف میکنیم 

 

 

 

 

 

 

 

 

 

 

 

𝐸𝑐 = (3300 × √21 + 6900) (
25

23
)

1.5

= 25956.557 Mpa 

 
= 𝐸𝑐 = (3300 × √𝑓𝑐 + 6900)(

𝛾𝑐

23
 E مدول الاستیسیته ،1.5(

 بتنی مشخصات مصالح

در جدول بالا کلیه مشخصات 

 درج شده است

 
 1-11شکل 

 نام دلخواه برای مصالح بتنی

 نوع مصالح

 همگن یا غیر همگن بودن مصالح

 مدول برشی  که نرم افزار خودکار حساب میکند
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 Modify/Show Material Property Designروی گزینه   Design Property Dataدر کادر Material Property Data  در پنجره 
 (0-02.شکل )مقاومت مشخصه را وارد می کنیم   Material Design Property Data کلیک کرده و در پنجره ی

 

 

 

 

 

 

 

 می شود :در نرم افزار ایتبس بار سقف به دو صورت بارکذاری 

ساتنیمتر بتن را حساب کرده و ما تنها بار گچکاری و سفیدکاری وپوکه ریزی و... را وارد  2نرم افزار به صورت خودکار بار  (0
کیلوگرم بر متر مربع محاسبه شده ما اگر بار سقف را با استفاده از روش  222کنیم یعنی برای مثال بار سقف طبقات برابر 

( حساب کرده و به بار وارده 2.22*  0222کم کنیم زیر ا نرم افزار ) 222کیلو گرم بر متر مربع از  022اول وارد کنیم باید 
 اضافه میکند.این روش در نزد محاسب ها کاربرد زیادی ندارد

 222در این روش ما در تعریف مصالح یک بتن با وزن واحد حجم صفر تعریف می کنیم ولی در اعمال بار سقف همین  (0
سانتیمتر بتن را در نظز نمی گیرد پس  2وارد میکند یعنی بار   (0.05*0ر متر مربع را وارد میکنیم چون نرم افزار )کیلو گرم ب

 .ما از این روش استفاده میکنیم

 : C0تعریف بتن 

تعریف  C0کپی گرفته و مصالحی با نام   Add Copy of Materialکه در بالا تعریف کردیم از طریق گزینه ی   C21از مصالح 
 ( تغییرات را انجام می دهیم:0-04میکنیم و مطابق شکل)

 

 

 

 

 

 

 
 1-11شکل  

 

 1-11شکل 

 C0در  تعریف بتن 

باید دو گزینه 

موردنظر صفر وارد  

 شود.

 مقاومت مشخصه بتن
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 مگاپاسگال می باشد. 00نکته: طبق مبحث نهم برای سازه هایی با شکل پذیری متوسط حداقل مقاومت مشخصه 

 تعریف میلگرد:

 Material Property را کلیک می کنیم و در پنجرهModify /Show Materialانتخاب کرده و سپس گزینه ی A615 Gr60گزینه 
Data  مصالحی با نامAIII  تغییرات را انجام دهیم: (0-02مطابق شکل )برای تعریف میگلرد باید  تعریف میکنیم 

 

 

 

 

 

 

 

 

 

 

 Modify/Show Material PropertyDesignروی گزینه   Design Property Dataدر کادرMaterial Property Data در پنجره 
 (0-06.شکل )را وارد می کنیم  میلگردتنش تسلیم و تنش نهایی   Material Design Property Data کلیک کرده و در پنجره ی

دو مورد در تعریف فولاد یا میلگرد )تنش تسلیم موردانتظار و مقاومت کششی مورد انتظار (  به نرم   ETABS 2015در نرم افزار 
مبحث نهم مقررات ملی برای پیدا کردن تنش تسلیم ومقاومت کششی مورد  2-0-0-02-2افزار اضافه شده است که مطابق بند 

 م.ضرب می کنی 0.02انتظار باید تنش تسلیم و تنش گسیختگی را به 

 

 

 

 

 

 
 

 1-16شکل

 

نام دلخواه برای میلگرد مورد استفاده در این 

هم برای میلگرد طولی  AIIIپروژه ، از میلگرد 

 و هم عرضی استفاده شده است

 است Rebarنوع مصالح برای تعریف میلگرد 

 وزن واحد حجم میلگرد

 مدول الاستیسیته میلگرد

 جرم واحد حجم میلگرد

تنش تسلیم و تنش برای تعریف 

نهایی میلگرد روی این گرینه 

 کلیک میکنیم
 1-11شکل 

𝐹𝑦𝑒 = 𝐹𝑦 × 1.25 = 400 × 1.25 = 500 𝑀𝑝𝑎 

𝐹𝑢𝑒 = 𝐹𝑢 × 1.25 = 600 × 1.25 = 750 𝑀𝑝𝑎 
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 تعریف مقاطع )تیر وستون(:

 برای تعریف تیر و ستون باید مسیر زیر را اجرا کنیم:

 

 (0-00) شکل Frame Properties توضیحات کلی درباره ی پنجره 

 

 

 

 

 

 

 

 

 

 تعریف مقطع ستون:

و   42*42وطبقه دوم وسوم را  42*42ستون طبقه اول را به صورت تجربی  )قاب خمشی(برای این پروژه که پیلوت + چهار طبقه
 . نظر می گیریمدر  22*22طبقه چهار و پنجم را 

 چند نکته مهم:

 در نرم افزار ایتبس دو حالت برای تعریف ستون وجود دارد  (0
  حالت اول:

مقاطع را در نرم افزار تعریف کرده و تعیین مساحت مورد نیاز میلگرد را بر عهده نرم افزار میگذاریم که این روش را 
 بیشتر مهندسین تازه وارد انجام میدهند.

 حالت دوم:
و هم چنین تعداد میلگرد را به نرم افزار تعریف میکنیم فقط نرم افزار کنترل میکند که تعداد میلگرد ها جوابگو مقاطع 

 هستند یا نه ) این روش بیشتر نزد محاسب ها کاربرد دارد(
 مکه ما برای از حالت اول در پروژه اول استفاده میکنیم که در پروژه های بعدی حالت دوم را به کار می گیری

این امکان به نرم افزار اضافه شده که می توانیم تعداد خاموت ها و نو ع میلگرد و هم چنین   ETABS 2015در نرم افزار  (0
 فاصله خاموت ها را به نرم افزار معرفی کنیم

 در ایتبس ضخامت کاور بتنی از کاربر سوال می شود  که این ضخامت کاور بتن در تیرو ستون فرق میکند در ستون ها (2

میباشد که با توجه شرایط محیطی که در آیین نامه  2ضخامت کاور بتنی همان حداقل پوشش رویه آماتورها در مبحث 

 حذف تکی مقاطع

این گزینه ها بیشتر در سازه های 

فولادی مورد استفاده خواهد شد که 

در پروژه سازه فولادی توضیح داده 

 خواهد شد

  …Define > Section Properties > Frame Sections  منوی

 

 وارد کردن مقاطع آماده

 تعریف مقاطع جدید 

 کپی از مقاطع تعریف شده از قبل

 ویرایش مقاطع تعریف شده

 حذف دستی از مقاطه به صورت کلی

 1-17شکل
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بلکه مقدار درخواستی برای کاور در  امده در نظر می گیریم ولی تیر ها  از این قانون در ایتبس تبعیت نمی کند 2مبحث 

در نظر گرفته می شود یعنی در هنگام وارد کردن ضخامت کاور بتنی ایتبس از مرکز آرماتورهای طولی  تا سطح خارجی 
 + قطر خاموت + نصف قطر میلگرد طولی 2در تیر ها باید مقدار پوشش بتنی آمده در مبحث 

 : 54*54تعریف ستون 

 :مسیر زیر را اجرا می کنیم

 

باز شود  Frame Property Shape Typeکلیک کرده تا پنجره  ...Add New Propertyروی گزینه Frame Propertiesدر پنجره ی 
 روی آیکون مستطیلی شکل کلیک می کنیم Concreteدر قسمت   Frequenty Used Shape Typeدر این پنجره باز شده در کادر 

 ( کلیه جزئیات توضیح داده شده است.0-02در شکل )باز شود  Frame Sections property Data( تا پنجره ی 0-02مطابق شکل )

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 1-19شکل 

 مقطع ستون ارتفاع

 مقطع تیر عرض

تعیین تعدا میلگردو 

 فاصله و نوع آن ها

مشخصات مقطع ماند 

 جدول اشتال

 

  …Define > Section Properties > Frame Sections  منوی

 ییلآیکون مستط

 1-18شکل

 

نام دلخواه برای مقطع 

 تعریف شده

انتخاب نوع مصالح از 

قبل تعریف شده برای 

 مقطع مورد نظر

تعیین ضریب ترک 

 خودگی

 ارتفاع ستون

مشخصات مقطع 

اطلاعاتی همانند 

 دول اشتالج

 عرض ستون
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( جزئیات پنجره 0-02پنجره ی همانند شکل زیر نمایش داده می شود که در شکل ) …Modify/Show Rebar با کلیک روی گزینه 
  گفته شده است.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

و در پنجره جاری در بالا  باز می گردیم Frame Sections property Dataرا زده وبه صفحه ی  OKبعد از تنظیمات بالا دکمه 
 .را همانند روش بالا درست می کنیم عمقاط هبقیسمت چپ مقطع ستون با آرایش میلگرد ها مشخص می شود.

 

 )در اینجا باید این گزینه فعال باشد( برای تعریف ستون

 تیربرای تعریف 

 نوع میلگرد طولی

 

 نوع میلگرد عرضی

 

شکل مستطیلی 

 میلگرد گذاری

 شکل دایراه ای 

 

 تنگخاموت از نوع 

 

 حالت کنترل میلگرد

 حالت طراحی میلگرد 

 کاور بتنی 

 تعداد میلگرد 

 

 شماره میلگرد

شماره میلگرد در  

 گوشه

 شماره میلگرد خاموت 

 فاصله میلگرد خاموت

 

 عرضی تعداد میلگرد

 

 خاموت از نوع دایره ای

 

 1-12شکل

به خاطر این که ما طراحی ستون را در 

قرار دادیم نیازی به  Designحالت 

 تنظمیات تعداد و شماره میلگرد نیست
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 تعریف مقطع تیر:

 ( در نظر می گیریم. 22*22( ، طبقه سوم و چهارم )42*42( ، طبقه اول و دوم )42*42با توجه به تجربه مهندسی طبقه پیلوت )

  ( در این جا در 42*42( است ولی ابعاد تیر )42*42تیر باید نحوه ی اجرا را درنظر بگیریم مثلا ابعاد ستون ما )در تعریف
قالبندی دچار مشکل می شود سعی بر آن باشد که ابعاد تیر همانند ابعاد ستون در نظر گرفته شود ولی در بعضی مواقع 

 ریم.که این شرایط ممکن نباشد عکس قضیه را درنظر می گی

 : 52*52تعریف تیر 

 :مسیر زیر را اجرا می کنیم

 

باز شود  Frame Property Shape Typeکلیک کرده تا پنجره  ...Add New Propertyروی گزینه Frame Propertiesدر پنجره ی 
روی آیکون مستطیلی شکل کلیک می کنیم  Concreteدر قسمت   Frequenty Used Shape Typeدر این پنجره باز شده در کادر 

 ( کلیه جزئیات توضیح داده شده است.0-00باز شود در شکل ) Frame Sections property Data( تا پنجره ی 0-00مطابق شکل )

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 ییلآیکون مستط

  …Define > Section Properties > Frame Sections  منوی

 1-11شکل

 

نام دلخواه برای 

 مقطع تعریف شده

انتخاب نوع مصالح از 

قبل تعریف شده برای 

 مقطع مورد نظر

 مقطع تیر ارتفاع

 1-11شکل تیر مقطع عرض
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( جزئیات پنجره 0-02پنجره ی همانند شکل زیر نمایش داده می شود که در شکل ) …Modify/Show Rebar با کلیک روی گزینه 
  گفته شده است.

 

 

 

 

 

 

 

 

که دیگر مانند ستون تعداد وآرایش میلگرد ها نمایش  بر می گردیم Frame Sections property Dataبعد از تنظیمات بالا به پنجره 
ایستگاه مساحت میلگرد مورد نیاز را در بالا و  2( زیرا نرم افزار ایتبس در مقطع تیر بعد از  طراحی در 0-04داده نمی شود.شکل)

 را از کاربر نمی خواهد.پایین نمایش می دهد به همین خاطر در تعریف تیر نرم افزار تعداد و شماره میلگرد 

 

 

 

 

 

 

 (درست می کنیم.0-02کلیه  مقاطع تیر و ستون مانند شکل زیر)

  

 

 

 

 

 

 

 1-11شکل

 برای تعریف مقطع تیر باید این گزینه فعال باشد 

 یرپایین ت کاور بتنی در بالا و

 1-11شکل

 

 

 1-11شکل

http://www.omraniha.com


 نویسنده:سعید مرتضوی                                                                ETABS2015 آموزش نرم افزار

 تعریف سقف:

برای اینکه نرم افزار بتواند بار سطحی طبقات را به تیر و ستون بدهد باید یک المانی به نام سقف تعریف کنیم ما در این پروژه دو 
( سقفی برای طبقات همان طور که 0( سقفی برای جلوی آسانسور که باید از نوع دال بتنی باشد 0المان سطحی تعریف می کنیم 
 .نوع این سقف از نوع سقف تیرچه بلوک می باشد در مشخصات پروژه گفته شد 

 تعریف دال بتنی:

مقررات ملی ساختمان آمده است ارتفاع را مشخص می کنیم  2برای تعیین ارتفاع حداقل برای دال بتنی طبق جدولی که در مبحث 

زیر استفاده  میکنیم اگر نسبت طول  حالا اینکه چگونه تشخیص دهیم که دال را به صورت یک طرفه یا دو طرفه است از فرمول .
 ( زیر داریم:0-06شد دو طرفه می باشد.با توجه به شکل ) 0شد یک طرفه و اگر کوچکتر از  0به عرض بزرگ تر از 

 

 

 می باشد. دو طرفهپس دال به صورت 

 

 تکیه گاه ساده نام عضو
تکیه گاه از یک طرف 

 پیوسته
 کنسولی تکیه گاه از دو طرف پیوسته

 L/16 L/18.5 L/21 L/18 بتنیطرفه  یکدال 
 

 (S400)دال دوطرفه نوع میلگرد 
 چشمه درونی )بدون کتیبه(

L/33 

 

 حالا ضخامت دال بتنی برابر است با:

 .سانتی متر در نظر می گیریم 02سانتی متر آمده است ولی ما در جهت اطمینان آن را  6با توجه به اینکه ضخامت دال بتنی 

 حالا برای تعریف دال در نرم افزار مسیر زیر را اجرا می کینیم:

 

 (0-00.شکل )شودنمایش داده می  …Slab Properties بعد از اجرای دستور بالا پنجره 

0) Plank1)برای دال یکطرفه( 
0) Slab1)برای دال دو طرفه( 

 

 

 

L/33 = 1.9/33 =6 cm 

 

1.9 m 

1.9

1.5
= 1.26 < 2 

 حذف المان سطحی مورد نظر

 1-16شکل

  …Define > Section Properties > Slab Sections  منوی

 

 1-17شکل

 تعریف المان سطحی ) سقف ( جدید 

 کپی ازالمان سطحی )سقف( تعریف شده 

 ویرایش المان سطحی )سقف( تعریف شده
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کلیک   …Modify/Show Propertyکلیک کرده و سپس روی گزینه ی  Slab1به خاطر این که دال به صورت دو طرفه است روی 
 ( تنظیمات را انجام می دهیم.0-02نمایان شود مطابق شکل ) Slab Property Dataمی کنیم تا پنجره ی 

 

 

 

 

 

 

 

 

 Modeling Typeگزینه   
Membrane  سقف غشایی( ن ها پخش بار به صورت دو طرفه است به کار می رودآ این گزینه برای دال ها یی که در( 

Shell-Thin  سقف خمشی( ، اگر در تعریف دال از این گزینه ی رودنمن ها پخش بار به صورت دو طرفه است به کار آ این گزینه برای دال ها یی که در(
 کنسولی ها به کار می رود باید سقف را مش بندی کنیم استفاده کردیم که بیشتر برای سقف

Shell-Thick  سقف خمشی( ، از این گزینه برای مدل کردن ی رودنمن ها پخش بار به صورت دو طرفه است به کار آ این گزینه برای دال ها یی که در(
 اده کرد بیشتر برای دیوار برشی مناسب استالمان های سطحی ضخیم استفاده می شود که نباید از این گزینه در تعریف دال استف

 

 Typeگزینه Property Dataدر کادر 
Drop  

Ribbed  

Waffle  

مصالحی با نام صفر انتخاب شده است که ما باید در بارگذاری این دال بتنی مطابق عدد بدست  Slab Materialدر مقابل گزینه 
 را به المان سطحی وارد می کنیم. آمده از جدول زیر بار

لح مصا ع   (2kg/mشدت بار) وزن مخصوص ضخامت نو

 67.5 2250 0.03 موزائیک

 42 2100 0.02 ملات ماسه وسیمان

 30 600 0.05 پوکه ریزی

 250 2500 0.01 بتن 

 24 1600 0.015 گچ کاری

 6.5 1300 0.005 سفید کاری
 2kg/m 420  جمع کل:

 کیلوگرم متر مربع را وارد میکنیم. 402سطحی )دال بتنی( پس در بارگذاری 

 

 نام دلخواه برای المان سطحی

 المان سطحی مصالح مورد نظر برایانتخاب 

این گزینه نیاز به توضیحات بیشتر دارد که در 

پایین شکل توضیح داده است و لی در این جا 

Membrane را انتخاب می کنیم 

نوع دال مشخص میشود که 

 اننخاب می شود Slabدراینجا 

 ضخامت دال

 1-18شکل
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 تعریف سقف تیرچه بلوک:

از سقف های موجود  یممشکل مواجه نشوبا مدل سازی در در نرم افزار ایتبس سقفی با نام تیرچه بلوک وجود ندارد برای اینکه 
 استفاده کرده یعنی معادل سازی می کنیم.در نرم افزار 

یکی از مزایای استفاده از بتن صفر این است که شکل سقف و اهمیت تغییر شکل های آن اهمین چندانی ندارد به طور کلی نرم 
 Slab    0)Deck(0دو نوع مقطع برای المان سطحی دارد  ETABS2015افزار 

 

 

 

 

 برای تعریف سقف تیرچه بلوک مسیر زیر را اجرا می کنیم:

 

 

 (0-02.شکل )نمایش داده می شود …Deck Properties بعد از اجرای دستور بالا پنجره 

 

 

 

 

 

 

ظاهر شود:  Deck Property Dataمی زنیم تا پنجره ی  …Modify/Show Propertyکلیک کرده و سپس گزینه  Deck1روی 
 (0-22شکل )

خود به چند دسته تقسیم می شود.چون ما از بتن صفر استفاده میکنیم استفاده   Deck  لازم است بدانید که المان سطحی از نوع
 برای ما تفاوتی ندارد. Deckاز هر نوع 

 

 

 

 انواع مقطع

Deck 

Slab 

 سقف های تیرچه بلوک وتیرچه کرومیت و عرشه فولادی به کار می رود برای تعریف

 به کار می رود برای تعریف دال های بتنی تخت ، مجوف و پیش تنیده

  …Define > Section Properties > Deck Sections  منوی

 

Deck 
Filled  :  که تیرچه بلوک وکرومیت با آن معادل سازی می شود کاربرد داردبرای سقف عرشه فولادی. 

Unfilled :  به کار می رود.برای سقف عرشه فولادی که بدون بتن رویه است 

Solid Slab : .برای سقف کامپوزیت کاربرد دارد 

 1-19شکل
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 ذخیره کنید.نکته : بعد از انجام هر مرحله باید با اجرای مسیر زیر فابل خود را 

 

 (0-20نمایان میشود.شکل) Save Model File Asکه پنجره ی 

 ( را میزنیمCtrl+Sرا می زنیم تا فایل ذخیره گردد.بعد از اینکار فقط )  Svaeکه مسیر فایل مشخص کرده وسپس دکمه 

 

 

 

 

 

 نام دلخواه برای سقف مورد نظر

بالا توضیح داده نوع سقف که در 

شده است و چون بتن صفر است 

 انتخاب این گزینه اهمیتی ندارد

 نو ع مصالح به کار رفته

 مصالح فولادی به کار رفته

چون عرشه  درسقف میباشد

فولادی نیست باز هم انتخاب این 

 گزینه اهمیتی ندارد

 (cm 5ضخامت بتن روی تیرچه بلوک )

 (cm 25ارتفاع تیرچه بلوک )

 (cm 10عرض تیرچه )

 50)فاصله آکس به آکس تیرچه ها 

cm) 

وزن ورق فولادی به کار رفته که 

 باید صفر در نظر بگیریم

 

به دلیل اینکه 

بتن صفر به کار 

 یعنی است رفته

وزن واحد صفر 

است نیازی به 

تغییر این اعداد 

 نیست

 1-12شکل

تنظیمات گل مربوط به 

میباشدکه نیازی به میخ 

 تغییرات نیست

 Shift+Ctrl+S یا  File > Save As  منوی

 

 1-11شکل
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 معرفی الگو ی بار:

 توضیحات الگوی بارنام 

Dead شامل بار مرده ساختمان می شود مانند دیوار ها و کف های ساختمان به غیر از دیوارهای پارتیشن بندی 

LiveNR  کیلو گرم متر مربع باشد شامل بار زنده غیر قابل کاهش است( 055بار زنده غیر قابل کاهش )اگر بار زنده بیش از 

Live که قابل کاهش است کیلو گرم بر متر مربع می باشد. 055که  بار زنده طبقات مسکونی 

Leq بار زنده دیوار های جدا کننده که این بار را نمی توان کاهش داد 

Lr بار زنده پشت بام 

EX در جهت  یبار زلزله استاتیکX بدون خروج از مرکزیت اتفاقی 

EY در جهت  یبار زلزله استاتیکY بدون خروج از مرکزیت اتفاقی 

EXP در جهت  یبار زلزله استاتیکX مثبت با خروج از مرکزیت اتفاقی 

EXN در جهت  یبار زلزله استاتیکX منفی خروج از مرکزیت اتفاقی اب 

EYP در جهت  یبار زلزله استاتیکY مثبت خروج از مرکزیت اتفاقی با 

EYN در جهت  یبار زلزله استاتیکY منفی ج از مرکزیت اتفاقیخرو با 

Mass باری برای اصلاح جرم طبقات است 

 

 دستور زیر را اجرا می کنیم:برای وارد کردن این الگو های بار 

 

 (0-20ظاهر می شود.شکل ) Define Load Patternsبا اجرای دستور بالا پنجره ی 

 

 

 

 

 

 

 

 مراحل زیر را باید انجام دهیم: LiveNRبرای مثال برای وارد کردن الگوی بار 

 ( وارد می کنیم.LiveNRنام موردنظر ) Loadدر قسمت  (0
 ( انتخاب گردد چون غیر قابل کاهش است.(Liveتخاب می کنیم که در این جا باید ننوع الگوی بار را ا Typeدر قسمت  (0
 کلیک می کنیم تا به الگو های بار ما اضافه گردد. Add New Loadسپس بر روی دکمه  (2

 زلزله مراحل زیر را انجام می دهیم:الگوی بار مرحله را می توانید برای الگوی بارهای مرده و زنده انجام دهید.برای تعریف  2این 

 باشد Roof Liveبار زنده پشت بام که باید 

 

 باشد چون قابل کاهش است Reducible Liveاز نوع  بار زنده طبقات که باید 

 …Define > Load Patterns  منوی

 1-11شکل
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 ( وارد می کنیم.EXنام موردنظر ) Loadدر قسمت  (0

 .( انتخاب گرددSeismicنوع الگوی بار را انتخاب می کنیم که در این جا باید ) Typeدر قسمت  (0
به صورت خودکار  انتخاب گردد تا بار جانبی را نرم افزار User Coeffiicientباید گزینه  Auto Lateral Loadدر قسمت  (2

محاسبه کردهو به سازه اعمال کند.)در این قسمت آیین نامه های مختلفی وجود دارد که می توانید به اختیار یکی از آن 
 ها را انتخاب کنید(

 (0-20شکل)کلیک می کنیم تا به الگو های بار ما اضافه گردد. Add New Loadسپس بر روی دکمه  (4
ضریب  Seismic Load Patternرا انتخاب کرده تا در پنجره ی  Modify Lateral Loadبعد از اضافه شدن باید گزینه ی  (2

 (0-22زلزله و همچنین جهت وارد کردن بار زلزله مشخص گردد.شکل )

 

 

 

 

 

 

 

 

 

 

 

 

 توضیحات نام کادر

Direction and Eccentricity 

XDir  بار زلزله در جهتX  بدون خروج از مرکزیت باشد. فقط این
 تیک فعال باشد بقیه تیک ها برداشته شود.

YDir  بار زلزله در جهتY  بدون خروج از مرکزیت باشد. فقط این
 تیک فعال باشد بقیه تیک ها برداشته شود.

XDir + Eccentricity  بار زلزله در جهتX  با خروج از مرکزیت مثبت باشد. فقط این
 تیک فعال باشد بقیه تیک ها برداشته شود.

XDir - Eccentricity  بار زلزله در جهتX  با خروج از مرکزیت منفی باشد. فقط این
 تیک فعال باشد بقیه تیک ها برداشته شود.

YDir + Eccentricity  بار زلزله در جهتY  با خروج از مرکزیت مثبت باشد. فقط این
 تیک فعال باشد بقیه تیک ها برداشته شود.

YDir - Eccentricity  بار زلزله در جهتY  با خروج از مرکزیت منفی باشد. فقط این
 تیک فعال باشد بقیه تیک ها برداشته شود.

 

 1-11شکل

 

 1-11شکل
 تو ضیحات کامل پنجره بالا در جدول زیر آمده است
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 توضیحات نام کادر

Factors 
Bsae Shear Coefficient , C  در اینجا باید ضریب زلزله اعمال شود.قبلا محاسبه شده است 

Building Height Exp , K  ضریبK که قبلا محاسبه شده است باید در اینجا وارد کنیم 

 

 توضیحات نام کادر

Story Range 
Top Story   مشخص کردن آخرین طبقه که بار زلزله تا آن طبقه اثر می کند که ما خرپشته را در نظر نگرفتیم 

Bottom Story  مشخص کردن پایین ترین طبقه که زلزله از آن طبقه وارد می شود. در صورت وچود زیرزمین موضوع
 فرق میکند که در پروژه های بعدی درباره ی آن صحبت خواهیم کرد. 

 

همین روند را تکرار می کنیم. فقط یه نکته ضریبی که در بالا برای  (EY , EXP , EXN , EYP , EYN)برای الگو ی بار های دیگر 

EX  وEY ( وارد میکنیم باEXP , EXN , EYP , EYN فرق میکند این تفاوت را قاعده )22به وجود می آورد. اول قاعده  022-22-
 ویرایش های لازم را انجام می دهیم.را توضیح داده سپس  022

 :122-02اعمال قاعده 

ساختمان ها باید در دو امتداد عمود برهم به صورت جداگانه در برابر بارهای   4ویرایش  0222آیین نامه  (4-0-2بر اساس بند)
جانبی )زلزله( طراحی شوند.بر اساس همین بند اگر یکی از شرایطی که در زیر وجود داشته باشد باید اثرات همزمان زلزله در دو 

 راستای متعامد ساختمان  در نظر گرفته شود.

 ساختمان نامنظم درپلان باشد (0
 کلیه ستون ها یی که در محل تقاطع دو یا چند سیستم مقاوم باربر جانبی هستند (0

به این خاطر است که ما نمی توانیم زاویه مناسبی برای  اینکه حداکثر اثر را بر روی سازه داشته باشد را پیدا  022-22این قاعده 
درصد نیروی زلزله در هر امتداد را  022که می توان  یک روش ساده ی را مطرح کرده است  0222کنیم به همین خاطر آیین نامه 

 درصد نیروی زلزله در امتداد عمود برآن جمع کرد تا بحرانی ترین حالت اتفاق بیفتد. 22با 

ارضا نمی شود چون در هر دو راستا ما قاب خمشی  0ارضا می شود چون سازه ما در پلان منظم می باشد. ولی بند  0در پروژه ما بند 
را استفاده کنیم  022-22ر گرفته ایم  پس کلیه ستون ها در محل تقاطع  دو سیستم مقاوم باربر جانبی هستند.پس باید قاعد در نظ

 در نرم افزار وجود دارد: 022-22. حالا دو راه برای اعمال قاعد 

 (EX , EYدر ضریب زلزله بار های استاتیکی زلزله بدون خروج از مرکزیت اتفاقی ) 2.2ضرب کردن  (0
 در ترکیب بارها  022-22اعمال کردن قاعد  (0

 (2-22) (0-24با توجه به حالت اول را با مطابق شکل ) 022-22در این پروژه ما هر دو روش را نشان خواهیم داد در اینجا قاعد 
ضرب می کنیم و نیازی به تغییر ضریب زلزله   EYو  EXرا فقط در ضریب زلزله  2.2انجام می دهیم برای یادآوری و تاکید بیشتر 

 تغییرات ضریب زلزله:.(2-26شکل ) نیست  EXP , EXN , EYP , EYN در 

 (𝐸𝑋, 𝐸𝑌) 𝐶 = 0.1572 × 0.3 = 0.0471 
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یکی از دو راستای نیروی محوری ایجاد شده در آن کمتر از اگر در ستونی برای اثر زلزله در  0222( آیین نامه 4-0-2بر مبنای بند )
نیست. این بند برای ستون هایی در پلا نامنظم در  022-22درصد ظرفیت بار محوری ستون باشد نیازی به در نظر گرفتن قاعد  02

 نظر گرفته نمی شود.

 

 

 1-11شکل

 1-11شکل

 ضرب شده است 2.1فقط ضریب زلزله به 

 ضرب شده است 2.1فقط ضریب زلزله به 

 1-16شکل
چون الگوی بار زلزله استاتیکی با خروج از مرکزیت اتفاقی است 

 نیست 122-12نیازی به تغییر ضریب زلزله برای اعمال قاعده 

 

http://www.omraniha.com


 نویسنده:سعید مرتضوی                                                                ETABS2015 آموزش نرم افزار

 : Massمعرفی الگوی بار 

 (0-20شکل ) .را انجام می دهیم  Massبرای تعریف این الگوی بار همانند الگوی بار مرده  یا زنده  تعریف بار 

 ( وارد می کنیم.Massنام موردنظر ) Loadدر قسمت  (0
 ( انتخاب گردد (Otherنوع الگوی بار را انتخاب می کنیم که در این جا باید  Typeدر قسمت  (0
 کلیک می کنیم تا به الگو های بار ما اضافه گردد. Add New Loadسپس بر روی دکمه  (2

 

 

 

 

در نظر گرفته   Otherو به همین خاطر از نوع  این بار به عنوان یک بار مانند بار مرده نیست که در ترکیب  بار وجود داشته باشد
شده است. از این الگوی بار برای تعیین  وزن لرزه ای سازه )یکی از مزایای ایتبس این است که می تواند وزن سازه را حساب کند.( 

به کار می رود. در واقع از این الگوی بار برای اصلاح وزن لرزه ای در پشت بام استفاده می شود چون در تعیین وزن دیوار های 
باید نصف از بالا و نصف از پایین حساب کنیم به خاطر اینکه ارتفاع پشت بام )جان پناه( با ارتفاع طبقه پایین خود مساوی  پیرامون

 نیست باید اصلاحی در آن صورت بگیرد.

 بار قائم زلزله:

 ئم زلزله در نظر گرفته شود:در یکی از شرایط زیر باید نیرو قا 4ویرایش  0222( آیین نامه 0-2-2-2( و )0-2-2-2بر مبنای بند )

 در صورت وجود بالکن )تراس( (0

 متر باشد 02تیرهایی که طول دهانه ی آن ها بیش از  (0
 برای ساختمان هایی که در پهنه با خطر نسبی خیلی زیاد قرار دارند (2

 برای درک بیشتر فرمول بار قائم زلزله در بالکن)تراس( را برای شما می نویسیممورد ذکر شده در این پروژه  وجود ندارند ما  2

 

A نسبت شتاب مبنای طرح : 

I ضریب اهمیت ساختمان : 

تعریف می شود همانند بار  Otherاگر در پروژه ما تراس بود باید در الگوی بار بار قائم را وارد می کردیم که از نوع  نکته مهم:
Mass .تعریف می شود 

 حالت بار ها:

 وقتی الگوی باری تعریف می شود نرم افزار به صورت خودکار حالت های باری متناظر با الگوی  ETABS 2015در نرم افزار 

 

 1-17شکل

𝐹𝑉 = 0.6𝐴𝐼𝑊𝑝  

 

Wp  بار زنده +  بار مرده=
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حالت بار با الگوی بار متفاوت می باشد در الگوی بار نوع بار مشخص می شود و لی در حالت بار  نوع  تعریف شده را می سازد.
 الگوی بار به نرم افزار معرفی می شود که نرم افزار برای تحلیل سازه از آن استفاده میکند. رفتار

نرم افزار ایتبس چنین حالتی وجود نداشت الگوی با را کاربر تعریف می کردو نرم افزار به صورت خودکار  9.7.4در نسخه  نکته:
 حالت های بار در نظر می گرفت.

 مسیر زیر را اجرا می کنیم:

 

 (0-22ظاهر می شود. شکل ) Load Casesبا اجرای دستور بالا پنجره ی 

 

 

 

 

 

 

 

 

با توجه به شکل بالا مشاهده می شود که نرم افزار ایتبس برای هر الگوی بار یک حالت بار متناظر تعریف کرده است. چون ما در 
این پروژه از تحلیل استاتیکی خطی استفاده می کنیم نیازی به تغییر پیش فرض نرم افزار نیست در پروژه های بعدی که از تحلیل 

کلیک کرده سپس  Deadیش تر با این پنجره کار خواهیم کرد. برای درک بیشتر موضوع اگر بر روی بکرد دینامیکی استفاده خواهیم 
برای مثال حالت بار نمایان می شود که که می توان   Load Case Dataرا انتخاب کنیم پنجره ی  …Modify/Show Caseگزینه ی 

 (0-22ت استاتیکی غیر خطی تبدیل کرد.مانند شکل )، بار مرده را از حالت استاتیکی خطی خارج کرده و به حال

 

 

 

 

 

 

 

 …Define > Load Cases  منوی

 
 1-18شکل

 1-19شکل
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 :(𝛒)تعیین درجه نامعینی سازه

ساختمان هایی که سیستم  مقاوم جانبی در دو جهت عمود برهم دارای نامعینی  4ویرایش 0222آیین نامه  (0-2-2بر مبنای بند )
 افزایش داد. (0.0) درصد 02کافی نباشد باید برش پایه ی ساختمان را 

برای مثال شما یک تیر ساده را در نظر بگیرید با ایجاد یک مفصل پلاستیک تیر ناپایدار می شود ولی حالا یک تیر دو سر گیردار را 
مفصل پلاستیک تشکیل شود تا تیر ناپایدار شود پس در حالت کلی اگر سازه ما دارای درجه نامعینی کافی داشته  2فرض کنید باید 

درصد برش پایه را  02برای سازه هایی که نامعینی کافی ندارند  0222لکرد خوبی خواهد داشت. به همین خاط آیین نامه باشد عم
 افزایش می دهد.

 در نظر گرفت: 0در چه شرایطی می توان در جه نامعینی را 

 ساختمان منظم باشد (0

 درصد نیروی برشی کل نباشد 22نیروی برشی موجود درآن طبقه بیشتر از  (0
در پلان ساختمان حداقل در دو طرفه مرکز جرم مهاربند وجود داشته باشد.در سازه بتنی  که دیوار برشی دارد تعیین  (2

شد پس سازه در پلان دارای  0مهاربند فرق می کند یعنی باید طول دیوار را تقسیم بر ارتفاع کرد اگر حاصل بیش تر از 
 دو مهاربند می باشد.

 می باشد. 0.2آمریکا ضریب درجه نامعینی سازه در آیین نامه نکته:

 .به برش پایه یعنی ما ضریب رفتار سازه را پایین می آوریم 0.0با اعمال ضریب  نکته:

 را اعمال کنید که در جهت اطمینان می باشد. 0.0اگر در محاسبه درجه نامعینی سازع دچار مشکل شدید همان ضریب  نکته:

 شرط بالا را کنترل کنیم : 2سازه دارای سیستم قاب خمشی است ما باید در این پروژه به خاط اینکه 

 ساختمان در پلان و ارتفاع منظم است پس بند اول ارضا می شود (0
چون سازه  دارای ارتفاع کمی می باشد به احتمال زیاد این بند هم برای سازه ما صادق است بیشر این بند برای سازه هایی  (0

می  فزارنرم ا با  برش طبقاتی که را شود ولی در حالت کلی باید پس از تحلیل نرم افزار این بندطبقه ارضا نمی  0بیش از 
 درصد برش پایه نباشد. 22که برش طبقه ای بیش از  دهد کنترل گردد.

ر  دو تی  y  دو تا تیر و در جهت  xکنیم. چون در جهتمی در قاب خمشی ما باید تعداد تیر های دو سر گیردار را حساب  (2
 دو سر گیردار داریم پس دارای مهاربند کافی در دو جهت مرکز جرم است.

ρپسشرط بالا برای اینکه درجه نامعینی  سازه یک باشد برقرار است  2چون  =  .در نظر می گیریم 1

 نکته خیلی مهم:

 نامعینی نیست:در برخی از ساختمان ها و همچنین در بعضی از کنترل های سازه نیازی به در نظر گرفتن درجه 

 طبقه  2ساختمان کمتر از  (0

𝑃محاسبه اثر (0 −  ∆ 

 محاسبه  تغییر مکان جانبی (2
 تعیین نیرو ها در سازه های غیر ساختمانی (4
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 کلیه اعضایی که شامل زلزله تشدید یافته می شوند (2

 تعریف ترکیب بار ها:

بسیاری از مهندسین را دچار  6ییر مبحث تعریف ترکیب بارها می باشد که با تغ ETABS 2015مهم ترین موضوع در نرم افزار
 اشتباه کرده است.

برای طراحی ساختمان بتنی به روش حالت حدی از ترکیب بارهای زیر استفاده  20مقررات ملی ساختمان ویرایش  6بر اساس مبحث 
 می کنیم:

0) 

0) 

2) 

کیلو نیوتن کمتر باشد به جز بار پشت بام و پارکینگ و یا محل  2می توان بار زنده ای که مقدار بار آن از  0در ترکیب بار  نکته:
 این ضریب فقط برای بار زنده است و نباید برای تیغه بندی در نظر گرفت. .در نظر گرفت2.6 برابر L های عمومی  می توان بار

چون در ضریب زلزله ضرب شده  وجود ندارد  022-22)در این ترکیب بار ها قاعده 0ترکیب بار برای سازه بتنی با درجه نامعینی 
 .فقط در بار های زلزله ضرب می شود. درجه نامعینی است(

 

 

1.25D+1.5Live+1.5LiveNR+1.5Leq+1.5Lr 
1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (EXP+EY) 
1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (EXP-EY) 

1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (-EXP+EY) 
1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84(-EXP-EY) 
1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (EXN+EY) 
1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (EXN-EY) 

1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (-EXN+EY) 
1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (-EXN-EY) 
1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (EYP+EX) 
1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (EYP-EX) 

1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (-EYP+EX) 
1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (-EYP-EX) 
1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (EYN+EX) 
1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (EYN-EX) 

1.25𝐷 + 1.5𝐿 + 1.5(𝐿𝑟) 

𝐷 + 1.2𝐿 + 1.5(𝐿𝑟) + 0.84𝐸 

0.85𝐷 + 0.84𝐸 

 است 1درجه نامعینی 
L  در نظر گرفته شده است 2.6برابر 

بندی  به بار زند تیغه 2.6

 اعمال نشده است
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1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (-EYN+EX) 
1.25Dead+0.6Live+1.2LiveNR+1.2Leq+1.2Lr+0.84 (-EYN-EX) 

0.85Dead+0.84(EXP+EY) 
0.85Dead+0.84(EXP-EY) 

0.85Dead+0.84(-EXP+EY) 
0.85Dead+0.84(-EXP-EY) 
0.85Dead+0.84(EXN+EY) 
0.85Dead+0.84(EXN-EY) 

0.85Dead+0.84(-EXN+EY) 
0.85Dead+0.84(-EXN-EY) 
0.85Dead+0.84(EYP+EX) 
0.85Dead+0.84(EYP-EX) 

0.85Dead+0.84(-EYP+EX) 
0.85Dead+0.84(-EYP-EX) 
0.85Dead+0.84(EYN+EX) 
0.85Dead+0.84(EYN-EX) 

0.85Dead+0.84(-EYN+EX) 
0.85Dead+0.84(-EYN-EX) 

 

 برای تعریف این ترکیب بارها به نرم افزار باید مسیر زیر اجرا کنیم:

 

 کلیک می کنیم…Add New Combo  باز شده و در آن جا روی گزینه ی Load Combinationsبعد از اجرای دستور بالا پنجره ی 
باشد  Linear Add روی حالت  Combination Typeو در قسنت  نام ترکیب بار Load Combinations Name سپس در قسمت

نوع  Load Nameدر قسمت  Define Combinations of Load Case/Combo Reaults که بهترین حالت است و سپس در کادر
 (0-42ضریب بار وارد می کنیم مانند شکل ) Scale Factorبار و در قسمت 

 

 

 

 

 

 

 …Define > Load Combinations  منوی

 1-12شکل 
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بقیه ترکیب بار ها را همانطور که دربالا توضیح داده شده است انجام می دهیم برای یادگیری بهتر می توانید از فیلم آموزشی 
 استفاده کنید.

 محاسبه وزن لرزه ای سازه:

+ کل بار   زنده )این درصد برای بار های مختلف زنده متفاوت است( بارمرده + درصدی از  باروزن یک سازه برابر است با کل 
 مسیر زیر را اجرا کنیم:. برای اعمال این فرمول به نرم افزار باید است دیوار های جداکننده

 

کلیک کرده و سپس روی گزینه  MsSrc1در این حالت بر روی  باز می شود Mass Sourceبعد از اجرای دستور بالا پنجره ی  
Modify/Show ( تنظیمات را انجام می دهیم:0-40کلیک می کنیم حالا مطابق شکل زیر ) 

 :0222( آیین نامه 0-2درصد مشارکت بار زنده  برمبنای جدول )

 %20 ساختمان مسکونی ، اداره ی ، هتل ها و پارکینگ ها
 %20 بیمارستان ها، مدارس، فروشگاه ها، محل اجتماع

 %40حداقل  کتابخانه ها و انبار ها
 %100 مخازن آب و سار مایعات

 

 

 

 

 

 

Multiplier Load Pattern 
1 Dead 

0.2 Live 
0.2 LiveNR 
1 Leq 

0.2 Lr 
1 Mass 

ولی در پروژه های بعدی توضیحات  در بالا گزینه های زیادی وجود دارد که ما در این پروژه از توضیح آن ها صرف نظر می کنیم 
 کافی داده خواهد شد.

 …Define > Mass Source  منوی

 

 1-11شکل

http://www.omraniha.com


 نویسنده:سعید مرتضوی                                                                ETABS2015 آموزش نرم افزار

 فصل سوم:

 ترسیم ستون ها:

کلیک کرده تا ساختمان را از نمای پلان نشان دهد) نرم افزار به صورت پیش فرض  برای ترسیم ستون ها روی آیکون  (0

 بر روی نمای پلان ساختمان را نشان می دهد(

 کلیک کرده تا فعال شود)به صورت پیش فرض فعال است(  در سمت چپ نوار ابزار حتما  روی آیکون (0

است که به صورت منوی کرکره ای  در پایین سمت چپ صفحه نمایش نرم افزار آیکونی به شکل مقابل  (2
فعال باشد ) با فعال شدن این گزینه مثلا اگر بر روی طبقه اول ستونی ترسیم کنیم  All Storiesمی باشد که باید گزینه 

 طبقات ستون ها ترسیم می شوند( در تمام

 ( زیر نمایش داده شود.2-0تا پنجره مطابق شکل) کلیک کرده سپس در سمت چپ نوار ابزار روی آیکون  (4
 

 

 

 

سپس موس را برروی شبکه های مه تعریف کرده بودیم برده و در آنجا طبق نقشه در هر جایی که ستون باید گذاشته  (2
 (2-0شود کلیک می کنیم مانند شکل )

 

 

 

 

 

 

 

 

  1-1شکل

ابعاد ستون را که قبلا درست کرده بودیم 

 مشخص میکنیم

 1-1شکل

ستون به ستون را مشخص  نوع اتصال

 ه به صورت گیردار است میکنیم  ک

 

الان باید بر روی این گره کلیک کرده 

 تا ستون گذاری انجام شود

http://www.omraniha.com


 نویسنده:سعید مرتضوی                                                                ETABS2015 آموزش نرم افزار

باشد و در بقیه طبقات )طبقه  42*  42در صورتی که طبقه پیلوت فقط باید است  42*  42الان  همه ستون های طبقات  (6

است( ابعاد ستون ها متفاوت می باشد حالا باید ابعاد ستون  22*  22وطبقه سوم و چهارم و خرپشته  42*  42اول و دوم 
 احل زیر را باید اجرا کنیمها را در طبقات تغییر دهیمبرای اینکار باید مر 

I) Select > Select > Object Type منوی 
II)  پنجره یSelect by Object Type   در پنجره  (2-2نمایان می شود)شکلSelect by Object Type    باید گزینهColumns  

 را می زنیم Closeرا می زنیم تا همه ستون ها انتخاب شود و بعد دکمه  Selectانتخاب کرده بعد دکمه 

 

 

 

 

 

 

 

 

III)  سپس مسیر مقابل اجرا می کنیمSelect > Deselect > Storiesمنوی 

IV)  طبقات دیگر  (2-4تغییر دهیم مانند شکل ) 42*  42به خاطر اینکه می خواهیم ابعاد ستو ن های طبقه اول و دوم  را به

 .می کنیم ولی طبقات اول و دوم را نباید انتخاب کرد چون از حالت انتخاب خارج  می شوند را انتخاب

 (2-2شکل) را می زنیم Closeزده و بعد  Deselectسپس دکمه       

 

 

 

 

 

 

 

 
 1-1شکل

 

 1-1شکل

 
 1-1شکل
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V) ( می بینیم فقط ستون های طبقه اول و دوم انتخاب شده است حالا2-2همانطور که در شکل )  باید ابعاد ستون ها را از

 تغییر بدیم برای این کار باید مسیر زیر را اجرا کنیم: 42*  42به  42*  42
VI) Assign > Frame > Section Property…را انتخاب  42* 42در پنجره ظاهر شده از لیست ابعاد ستون ها ابعاد   منوی

 را می زنیم. OKمیکنیم و بعد دکمه 

در سمت بالای  طبقات انجام می دهیم برای اینکه ابعاد مقطع در کنار المان ها نشان داده شود آیکون  همین کار برای بقیه

را فعال می  Sectionرفته و سپس گزینه ی  Object Assignmentsنوار ابزار است را انتخاب میکنیم در پنجره ی باز شده به تب 
 (2-6.شکل )کنیم

 

 

 

 

تا ستون باید  4پشت بام فقط  ستونه ها را درست کردیم ولی باید ستوهای خرپشته را اصلاح کنیم یعنی درتا اینجا ابعاد  (0
 باشد.

)این تغییر به  تغییر می دهیم  One Storyرا به حالت  All Storiesابتدا در سمت راست پایین حالت  (2

و سپس روی آیکون   تغییراتی که می دهیم فقط در آن طبقه اتفاق می افتد( One Storyخاطر این است که در حالت

 پلان خرپشته نشان داده شودرا می زنیم تا  OKرا انتخاب میکنیم و بعد  TOPکلیک کرده و در لیست باز شده 

ود(و ون انتخاب شوسپس ستون هایی که نباید در پلان باشد را انتخاب کرده)ماوس را از سمت راست به چپ کشیده تا ست
  را می زنیم. Deleteبعد از صفحه کلید دکمه  

 ترسیم تیرها:

کلیک کرده تا ساختمان را از نمای پلان نشان دهد) نرم افزار به صورت پیش فرض  برای ترسیم ستون ها روی آیکون  (0

 بر روی نمای پلان ساختمان را نشان می دهد(

 کلیک کرده تا فعال شود)به صورت پیش فرض فعال است( در سمت چپ نوار ابزار حتما  روی آیکون  (0

است که به صورت منوی کرکره ای  در پایین سمت چپ صفحه نمایش نرم افزار آیکونی به شکل مقابل  (2
ر ترسیم کنیم د تیریفعال باشد ) با فعال شدن این گزینه مثلا اگر بر روی طبقه اول  All Storiesمی باشد که باید گزینه 

 ات ستون ها ترسیم می شوند(تمام طبق

 ( زیر نمایش داده شود.2-0کلیک کرده تا پنجره مطابق شکل) سپس در سمت چپ نوار ابزار روی آیکون  (4

بعد از این کار ماوس را از آکس ستونی به آکس ستون دیگر می بریم تا تیر مورد نظر کشیده شود. اگر دوبار پشت سرهم  (2
خارج شده و می توانیم دوباره روی آکس دیگر ستون کلیک کرده و سپس ترسیم چپ کلیک کنیم ماوس از حالت ترسیم 

 (2-2)را آغاز کنیم

 
 1-6شکل
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باشد و در بقیه طبقات )طبقه اول  42*  42در صورتی که طبقه پیلوت فقط باید است  42*  42طبقات  تیرهایالان  همه  (6

است( ابعاد ستون ها متفاوت می باشد حالا باید ابعاد تیرها را  22*  22وطبقه سوم و چهارم و خرپشته  42*  42و دوم 
که در   ( 2-2فقط در شکل )ی دهیم در طبقات تغییر دهیم برای اینکار باید مراحلی که در ستون ها رفته ایم را انجام م

 و هم چنین حذف تیرها هم مانند ستون ها می باشد.(Beamستون انتخاب شده بود باید تیر انتخاب شود)

 ترسیم تیر به تیر)جای آسانسور(:

 

 را انتخاب کنیم صرفنظر می کنیم All Stroriesما در اینجا توضیحات اضافی که باید سازه در حالت پلان باشد و هم چنین  (0

( زیر نمایش داده شود. در پنجره 2-2کلیک کرده تا پنجره مطابق شکل) سپس در سمت چپ نوار ابزار روی آیکون  (0
 ( نتظیمات را انجام می دهیم.2-2شده مطابق شکل) باز

 

 

مثل ستون باید گیردار باشد چون سیستم  ما قاب خمشی است ولی اگر  برای مثال سازه ما سازه فولادی 

تغییر می دهیم و لی در ستون ها چه فولادی چه )مفصلی( Pinnedرا به  Continuousمهاربندی بود باید 

 .باشد زیرا باید لنگر انتقال داده شود Continuousبتنی باید 

 

 1-7شکل

 1-8شکل

این دو تا تیر به صورت تیر به تیر باید ترسیم شود چون شبکه ی 

از یک روش دیگه برای خطوط برای آن ها در نظر نگرفته ایم باید 

 ترسیم استفاده کنیم
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 .می بریم  Cبه سمت آکس ستون  D( ماوس را ازسمت چپ به راست از آکس ستون 2-02سپس مطابق شکل ) (2
 ترسیم می شود.  (2-00ما به صورت شکل ) پس از این مرحله تیر (4

 

 

 

 

 

 

( زیر نمایش داده شود. در پنجره 2-00کلیک کرده تا پنجره مطابق شکل) سپس در سمت چپ نوار ابزار روی آیکون  (2

 ( نتظیمات را انجام می دهیم2-00باز شده مطابق شکل)
6)  

 

 

 

 

 

 .می بریم  0به سمت آکس ستون  2از آکس ستون بالا به  پایین( ماوس را ازسمت 2-02سپس مطابق شکل ) (0
 ترسیم می شود.  (2-04پس از این مرحله تیر ما به صورت شکل ) (2

 
 

 1.1( به اندازه C-Dدر این جا می خواهیم تیر دهانه ی)

  شود به طرف پایین آفستمتر 

 

 

 

 1-9شکل

 1-11شکل 1-12شکل

 
 1-11شکل

 1.6( به اندازه 1-1جا می خواهیم تیر دهانه ی) در این

  شود به طرف جلو آفستمتر 
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 ( بعضی از تیرها  باید پاک و به انتهای بعضی ، تیر اضافه شود.2-02مطابق شکل) (2

 

 

 

 

 

 

 

 

و به انتهای آن قسمت از تیر  یر های موجود را انتخاب کرده( می بینید ت2-06حذف تیر اضافی همانطور که در شکل ) (02

پنجره Shift + Ctrl +M) که باید حذف شود کلیک میکنیم تا به صورت ستاره شود و سپس از طریق کلید های ترکیبی )
 را می زنیم. OKکرده و بعد را انتخاب   Trim Frame Objects( ظاهر شده و بعد گزینه 0-00مطابق شکل )

 

 

 

 

 

  
 1-11شکل 1-11شکل

 

 1-16شکل

تا این قسمت از تیر باید حذف 

 شود.

تا این قسمت از تیر باید اضافه 

شود چون در اینجا خطوط شبکه 

وجود دارد به همین خاطر نرم 

افزار نتوانسته تیر را به تیر مورب 

 وصل کند.

 

 
 1-17شکل
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( تیر مورد نظر و سپس تیری مقصد)تیر مورب( که میخواهیم تیر به آن وصل شود را 2-02اضافه کردن تیر همانند شکل ) (11

ا به صورت ت ضمن باید انتهای تیر مبدا باید انتخاب شده باشد یعنی در انتهای تیر کلیک می کنیمانتخایب میکنیم در 
( ظاهر شده و بعد گزینه 0-02پنجره مطابق شکل )Shift + Ctrl +M) ستاره شود و سپس از طریق کلید های ترکیبی )

Extend Frame Objects   را انتخاب کرده و بعدOK .را می زنیم 

 

 

 

 

 

 

 (2-02در حالت کلی داریم. شکل)

 

 

 

 

 

 

 ترسیم سقف:

کلیک کرده تا ساختمان را از نمای پلان نشان دهد) نرم افزار به صورت پیش فرض  برای ترسیم ستون ها روی آیکون  (0

 بر روی نمای پلان ساختمان را نشان می دهد(

 کلیک کرده تا فعال شود)به صورت پیش فرض فعال است( در سمت چپ نوار ابزار حتما  روی آیکون  (0

است که به صورت منوی کرکره ای  در پایین سمت چپ صفحه نمایش نرم افزار آیکونی به شکل مقابل  (2
وی طبقه اول سقفی ترسیم کنیم فعال باشد ) با فعال شدن این گزینه مثلا اگر بر ر  All Storiesمی باشد که باید گزینه 

 در تمام طبقات ستون ها ترسیم می شوند(

 ( زیر نمایش داده شود.2-00کلیک کرده تا پنجره مطابق شکل) سپس در سمت چپ نوار ابزار روی آیکون  (1

 

 

 1-18شکل

 1-19شکل

 
 1-12شکل

http://www.omraniha.com


 نویسنده:سعید مرتضوی                                                                ETABS2015 آموزش نرم افزار

ده انتخاب کرده و سپس ماوس را روی گره ها  بر  Deck1نوع سقف را  Propertyجلوی گزینه ی در پنجره ی ظاهر شده  (1

 (2-00و روی گره ها )آکس ستون ها( کلیک میکنیم مانند شکل )

 (2-02انتخاب کرده مانند شکل ) Openingنوع سقف  Propertyجلوی گزینه ی  برای سقف راه پله (6

 (2-04انتخاب کرده مانند شکل ) Slab1نوع سقف  Propertyبرای جلوی آسانسور جلوی گزینه ی  (7

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ی به نظر نرسد به همین علت برای تغییر جهت تیر ریزی ینحوهی تیر ریزی در بعضی از سقف ها شاید درست و اجرا (2
 سقف مورد نظر را انتخاب کرده و سپس مسیر زیر را اجرا می کنیم:

 
 

 درجه چرخش می دهیم( 22( تنظیمات را وارد می کنیم)یعنی تیرچه را 2-02ی ظاهر شده مطابق شکل ) در پنجره (2

 

 

 

 

 1-11شکل

 

 1-11شکل

 
 1-11شکل

 1-11شکل

Assign > Shell > Local Axes…منوی   
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 ( مشخص است.2-06تغییرات انجام شده در شکل )

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 نکته مهم:

چون سیستم ما قاب خمشی است پس سعی میکنیم تیر ریزی به شکل شطرنجی باشد ولی اگر سیستم به صورت دو گانه بود باید 
سعی می کردیم تیرچه ها عمود بر قاب خمشی باشد تا در کنترل دریفت مشکلی پیش نیاید زیر با اینکار از تغییر مکان قاب خمشی 

 جلو گیری می کنیم.

رفته و در آنجا روی سقف کلیک کرده  TOPانتخاب شده وسپس به طبقه برای اصلاح سقف خرپشته باید گزینه ی

 کلیک کرده و سقف را ترسیم میکنیم. و سپس روی  را می زنیم  Delete( و دکمه Opening)سقف به صورت 

 
 1-11شکل

  

 1-16شکل

 تغییرات صورت گرفته 

از لحاظ اجرایی درست نیست 

و باید انتهای همه تیرچه ها 

 بریده شود 
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باید باشیم  انتخاب می کنیم( در ضمن باید درحالت را  Baseکلیک کرده و بعد  برویم )روی  Baseاگر به 

می بینیم سقف در کف هم ترسیم شده است که باید آن ها حذف شوند از سمت راست به چپ کل پلان را انتخاب کرده و بعد 
 پروژه را ذخیره می کنیم. Ctrl + Sسپس با کلید ترکیبی  را می زنیم  Deleteدکمه ی 

 فصل چهارم:

 دیوار های پیرامون بدون نما:بارکذاری 

در سقف های اول ، دوم ، سوم ، چهارم را انتخاب کرده )با کلیک بر روی تیر ، تیر انتخاب می شود(  Dو  Aتیر های قاب  (0

راه های زیادی برای انتخاب وجود دارد که ما ساده ترین روش را ذکر کرده ایم در پروژه های بعدی با انتخاب المان ها 
 می شوید.زیاد آشنا 

 را فراخوانی میکنیم:  (4-0سپس از مسیر زیر پنجره ی شکل ) (0
 

 

 

 مقدار بار دیوار های پیرامون بدون نما در فصل اول توضیح داده شده است.

 

 

Assign > Frame Load > Distributed…منوی   

 

 نوع بار مشخص می شود که باید ازنوع مرده باشد

 اضافه کردن بار بر روی بار که از قبل وارد شده

 جایگزینی بار

 حذف بار

 1-1شکل مقدار بار محاسبه شده بر حسب کیلو گرم بر متر
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 نما: بارکذاری دیوار های پیرامون با

در سقف های اول ، دوم ، سوم ، چهارم را انتخاب کرده )با کلیک بر روی تیر ، تیر انتخاب می شود(  2و  0تیر های قاب  (0
راه های زیادی برای انتخاب وجود دارد که ما ساده ترین روش را ذکر کرده ایم در پروژه های بعدی با انتخاب المان ها 

 زیاد آشنا می شوید.
 مقابل را اجرا میکنیمدستور سپس  (0

 
کیلو گرم بر متر وارد می  600همانند بارگذاری دیوار های پیرامون بدون نما جلو می رویم با این تفاوت که مقدار بار را  (2

 .کنیم

 بارگذاری دیوار های جان پناه وخرپشته:

را انتخاب کرده )با کلیک بر روی تیر ، تیر انتخاب می شود( راه های زیادی برای  کل تیر های کناری خرپشته و پشت بام  (0

 انتخاب وجود دارد که ما ساده ترین روش را ذکر کرده ایم در پروژه های بعدی با انتخاب المان ها زیاد آشنا می شوید.
 نیممقابل را اجرا میک دستورسپس  (0

 
کیلو گرم بر متر وارد می  004همانند بارگذاری دیوار های پیرامون بدون نما جلو می رویم با این تفاوت که مقدار بار را  (2

 .کنیم

 سقف طبقات: بار مرده گذاریبار

 میکنیم با روش زیر انتخاب سقف ها انجام  می دهیمرا انتخاب  اول ، دوم ، سوم ، چهارمطبقه کل سقف های  (0
0) Select > Select > Object Type منوی 
انتخاب کرده  Floorsباید گزینه    Select by Object Typeنمایان می شود در پنجره   Select by Object Typeپنجره ی  (2

 .را می زنیم  Closeرا می زنیم تا همه سقف ها انتخاب شود و بعد دکمه  Selectبعد دکمه 
 منویSelect > Deselect > Storiesسپس مسیر مقابل اجرا می کنیم  (4
 می زنیم.  را Select  بعد در این جا همه ی طبقات را انتخاب کرده وبه جز پشت بام وخرپشته وسپس (2
 را فراخوانی میکنیم:  (4-0سپس از مسیر زیر پنجره ی شکل )  (6

 

 

 

 

 

 

 

  در فصل اول توضیح داده شده است.مقدار بار مرده سقف طبقات 

Assign > Frame Load > Distributed…منوی   

Assign > Frame Load > Distributed…منوی   

Assign > Shell Load > Uniform…منوی   

 
 1-1شکل
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 :پشت بام وخرپشتهسقف  بار مرده گذاریبار

 

انتخاب می شود( راه های زیادی برای  سقف،  سقفرا انتخاب کرده )با کلیک بر روی کل سقف پشت بام وخرپشته  (0
 ها زیاد آشنا می شوید. انتخاب وجود دارد که ما ساده ترین روش را ذکر کرده ایم در پروژه های بعدی با انتخاب المان

 سپس دستور مقابل را اجرا میکنیم  (0
 

وارد می  مربع کیلو گرم بر متر 222جلو می رویم با این تفاوت که مقدار بار را  بار مرده سقف طبقاتهمانند بارگذاری  (2
 .کنیم

 

 سقف طبقات: بار زنده گذاریبار

 همانند روشی که قبلا گفته شده است. را انتخاب کرده  اول ، دوم ، سوم ، چهارمکل سقف های طبقه  (0
 را فراخوانی میکنیم:  (4-2سپس از مسیر زیر پنجره ی شکل )  (0

 

 

 

 

 

 

 

  بار زنده سقف طبقات در فصل اول توضیح داده شده است.مقدار 

 

 :پشت بام وخرپشتهسقف  بار زنده گذاریبار

 

انتخاب می شود( راه های زیادی برای  سقف،  سقفرا انتخاب کرده )با کلیک بر روی  پشت بام وخرپشتهکل سقف  (0
 انتخاب وجود دارد که ما ساده ترین روش را ذکر کرده ایم در پروژه های بعدی با انتخاب المان ها زیاد آشنا می شوید.

0)  
 را فراخوانی میکنیم:  (4-4سپس از مسیر زیر پنجره ی شکل )  (2

Assign > Shell Load > Uniform…منوی   

Assign > Shell Load > Uniform…منوی   

 

 به جای بار مرده بار زنده انتخاب شده

Assign > Shell Load > Uniform…منوی   

 1-1شکل
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 :بار تیغه بندی در طبقات گذاریبار

 میکنیم با روش زیر انتخاب سقف ها انجام  می دهیمرا انتخاب  اول ، دوم ، سوم ، چهارمکل سقف های طبقه  (0

0) Select > Select > Object Type منوی 
انتخاب کرده  Floorsباید گزینه    Select by Object Typeنمایان می شود در پنجره   Select by Object Typeپنجره ی  (2

 .را می زنیم  Closeرا می زنیم تا همه سقف ها انتخاب شود و بعد دکمه  Selectبعد دکمه 
 منویSelect > Deselect > Storiesسپس مسیر مقابل اجرا می کنیم  (4

 ی زنیم.م  را Select  بعد در این جا همه ی طبقات را انتخاب کرده وبه جز پشت بام وخرپشته وسپس (2
 را فراخوانی میکنیم:  (4-2سپس از مسیر زیر پنجره ی شکل )  (6

 

 

 

 

 

 

 

 

 

 کلیک کرده وسپس قاب مورد نظر را انتخاب میکنیم. باید روی آیکون  0 نکته: مثلا برای رفتن به قاب

 کلیک می کنیم. بعدی روی آیکون  2نکته: برای نشان سازه به صورت 

 
 1-1شکل

Assign > Shell Load > Uniform…منوی   

 
 1-1شکل
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 : Massاصلاح بار دیوار های پیرامون پشت بام 

 

 

 ای زیادی برای انتخابرا انتخاب کرده )با کلیک بر روی تیر ، تیر انتخاب می شود( راه ه کل تیر های کناری پشت بام  (0
 وجود دارد که ما ساده ترین روش را ذکر کرده ایم در پروژه های بعدی با انتخاب المان ها زیاد آشنا می شوید.

 سپس دستور مقابل را اجرا میکنیم (0

 
کیلو گرم بر متر وارد می  220همانند بارگذاری دیوار های پیرامون بدون نما جلو می رویم با این تفاوت که مقدار بار را  (2

 (4-6انتخاب میکنیم شکل )  Massدر ضمن نوع بار را  .کنیم
 

 

 

 

 

 

 

 

 : Massصلاح بار دیوار های پیرامون طبقه اول  ا

 

 

را انتخاب کرده )با کلیک بر روی تیر ، تیر انتخاب می شود( راه های زیادی برای   فقط طبقه اولکل تیر های کناری  (0
 انتخاب وجود دارد که ما ساده ترین روش را ذکر کرده ایم در پروژه های بعدی با انتخاب المان ها زیاد آشنا می شوید.

 میکنیمسپس دستور مقابل را اجرا  (0

 
کیلو گرم بر متر وارد  -020.4همانند بارگذاری دیوار های پیرامون بدون نما جلو می رویم با این تفاوت که مقدار بار را  (2

 (4-0انتخاب میکنیم شکل )  Mass. در ضمن نوع بار را می کنیم
 

𝑀𝑎𝑠𝑠 =
662

2
= 331 𝑘𝑔/𝑚2 

 بار دیوار پیرامون بدون نما 

Assign > Frame Load > Distributed…منوی   

 
 1-6شکل

𝑀𝑎𝑠𝑠 =
ارتفاع پیلوت − ارتفاع طبقه اول

2
× 662 =

2.5 − 2.9

2
× 662 = 132.4 𝑘𝑔/𝑚 

Assign > Frame Load > Distributed…منوی   
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 : Massاصلاح بار سقف پشت بام 

 

 

انتخاب می شود( راه های زیادی برای انتخاب وجود  سقف،  سقفرا انتخاب کرده )با کلیک بر روی کل سقف پشت بام  (0
 دارد که ما ساده ترین روش را ذکر کرده ایم در پروژه های بعدی با انتخاب المان ها زیاد آشنا می شوید.

 را فراخوانی میکنیم:  (4-2زیر پنجره ی شکل ) مسیرسپس از   (0

 

 

 

 

 

 

 

 
 1-7شکل

 بار تیغه بندی  

𝑀𝑎𝑠𝑠 =
100

2
= 50 𝑘𝑔/𝑚2 

Assign > Shell Load > Uniform…منوی   

 
 1-8شکل 
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 : Massاصلاح بار سقف طبقه اول 

 

 

 پس نیازی به در نظر گرفتن اصلاح بار نیست.

 راه پله:بارگذاری 

 بهترین روش برای بارگذاری راه پله اعمال بار نقطه ای به چهار ستون اطراف پله می باشد.

 

 

 

و با علامت منفی )یعنی رو به پایین( باید دستور زیر را اجرا  Zبرای اعمال بار نقطه ای پله که باید در جهت  (1

  کنیم:

 ( بار مرده وزنده را وارد می کینم.4-02و) (4-2مطابق شکل ) (1

 

 

 

 

 

 

 

 

 

 

 بار تیغه بندی پارکینگ  

𝑀𝑎𝑠𝑠 =
100 − 100

2
= 0 

 بار تیغه بندی طبقه اول  

𝑞𝐷 =
3.5 × 5.8 × 570

4
= 2893 𝑘𝑔 𝑞𝐿 =

3.5 × 5.8 × 500

4
= 2538 𝑘𝑔 

 

 بار زنده مساحت بار مرده مساحت

Assign > Joint Load > Force…منوی   

 

 

 1-9شکل 

 1-12شکل 

بار زنده راه پله که غیر 

 قابل کاهش است
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 پنجم:فصل 

 اختصاص تکیه گاه گیردار به پای ستون )ستون متصل به پی(:

 قرار داشته باشیم ابتدا باید در حالت  (1

 می رویم  Baseبه  سپس با کمک  (1

 به کمک ماوس تمام ستون ها را انتخاب میکنیم )از سمت راست به چپ ستون ها را انتخاب می کنیم( (1

( ظاهر می شود. چون می خواهیم 2-0پنجره ی شکل )  منوی…Assign > Joint > Restraintsبا اجرای دستور مقابل  (1

 پای ستون گیردار شود باید همه درجات آزادی )انتقالی و چر خشی( محدود شود )همه آن ها را تیک می زنیم(.

 

 

 

 
 

 

 

 

 (1-1شکل) ETABS 2015شکل پای گیردار و مفصلی در نرم افزار 

 

 

 اختصاص نواحی صلب:

ب محل اشتراک تیر و ستون می باشد. نرم افزار ایتبس در ترسیم تیر یا ستون از آکس به آکس منظور از نواحی صل

که در واقعیت این درست نیست یعنی طول تیر یا ستون بیشتر از مقدار واقعی آن است اگر این ناحیه را  ترسیم میکند

اصلاح نکنیم باعث می شود سختی اعضا کاهش یافته و همچنین باعث افزایش خیز می شود برای حل این مشکل مراحل 

 زیر را انجام می دهیم.

 را می زنیم تا تمامی اعضا انتخاب شوند Ctrl + Aکلید ترکیبی  (1

   منوی…Assign > Frame > End Length Offsets  مسیر مقابل را اجرا می کنیم: (1

 
 1-1شکل 

به جای تیک زدن می توانیم 

روی این آیکون کلیک کنیم 

 تا پای ستون ها گیردار شود

 
 پای ستون گیردار پای ستون مفصلی

 1-1شکل 
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تنظیمات مطابق شکل یک عدد تجربی است و پایه واساس آیین نامه ای ندارد. 2.2( ظاهر شود.عدد 2-2تا پنجره ی شکل ) (1
 انجام شود.

 

 

 

 

 

 

 

 

 

 (1-1ناحیه صلب شکل )

 

 

 

 

 

 دیافراگم صلب:

 

 

 

 برای اعمال دیافراگم صلب به طبقات مراحل زیر را انجام می دهیم:

0) Select > Select > Object Type منوی 
انتخاب کرده  Floorsباید گزینه    Select by Object Typeنمایان می شود در پنجره   Select by Object Typeپنجره ی  (1

 .را می زنیم Closeرا می زنیم تا همه سقف ها انتخاب شود و بعد دکمه  Selectبعد دکمه 

   منوی…Assign > Shell > Diaphragms  مسیر مقابل را اجرا می کنیم: (1

 
 1-1شکل 

 
 1-1شکل 

ناحیه ای که نرم افزار باید آن را 

 نادیده بگیرد
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 را انتخاب میکنیم. D1( ظاهر می شود و در پنجره نمایان شده 2-2با اعمال دستور بالا پنجره ی شکل ) (1

 (2-6بعد از اعمال دیافراگم صلب شکل ) (1

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 اعمال ضریب ترک خودگی در ستون ها:

است ضریب ترک خودگی چون فرض را بر آن گرفتیم که قاب مهاربند نشده  1822( آیین نامه 1-1-1بر مبنای بند )

 در نظر می گیریم. مراحل اعمال ضریب ترک خوردگی در ستون ها: 2.7ستون را 

 منوی Select > Select > Object Typeستون ها را انتخاب میکنیم  (0

انتخاب   Columnsباید گزینه    Select by Object Typeدر پنجره  نمایان می شود  Select by Object Typeپنجره ی  (0
 را می زنیم Closeرا می زنیم تا همه ستون ها انتخاب شود و بعد دکمه  Selectکرده بعد دکمه 

   منوی…Assign > Frame > Property Modifiersسپس دستور مقابل را اجرا میکنیم:  (1

 هیم.( تنظیمات را انجام می د2-0( نمایان می شود طبق شکل )2-0با اجرای دستور بالا پنجره ی شکل ) (1

 

 

  

 1-6شکل  1-1شکل 
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 اعمال ضریب ترک خودگی در ستون ها:

چون فرض را بر آن گرفتیم که قاب مهاربند نشده است ضریب ترک خودگی  1822( آیین نامه 1-1-1بر مبنای بند )

 در نظر می گیریم. مراحل اعمال ضریب ترک خوردگی در ستون ها: 2.11تیر را 

 منوی Select > Select > Object Typeستون ها را انتخاب میکنیم  (0

انتخاب کرده   Beamsباید گزینه    Select by Object Typeدر پنجره  نمایان می شود  Select by Object Typeپنجره ی  (0
 را می زنیم Closeرا می زنیم تا همه ستون ها انتخاب شود و بعد دکمه  Selectبعد دکمه 

   منوی…Assign > Frame > Property Modifiersور مقابل را اجرا میکنیم: سپس دست (1

 ( تنظیمات را انجام می دهیم.2-2( نمایان می شود طبق شکل )2-2با اجرای دستور بالا پنجره ی شکل ) (1

 

 

 

 

 

 

 

 
 1-7شکل 

 
 1-8شکل 
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 فصل ششم:

 تنظیمات تحلیل سازه:

باید این زمان تناوب باید با زمان تناوب تحلیلی مقایسه شود برای اینکه نرم افزار درصد افزایش داده ایم که  02ما زمان تناوب را 
 زمان تناوب تحلیلی را محاسبه کند باید مراحل زیر را انجام می دهیم

   منوی… Define > Model Cases: دستور مقابل را اجرا می کنیم (1

  .ظاهر می شود (6-0بعد از اجرای دستور بالا پنجره ی شکل ) (1

 

 

 

 

 

 

( تنظیمات را 6-0می زنیم سپس در شکل )  Modify/Show Caseدر پنجره ی ظاهر شده در شکل بالا روی گزینه  (1
 ( انجام می دهیم6-0مطابق شکل )

 

 

 

 

 

 

 

 

 
 6-1شکل 

 

 می کنیم   1تعداد طبقه را ضربدر 

11=1*1 

 حداکثر مود را محاسبه میکنیم

 اصلاح می کنیمفقط این گزینه را 

 6-1شکل 
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 :P-Deltaتنظیمات 

   منوی… Define > P-Delta Options: دستور مقابل را اجرا می کنیم (1

 .( ظاهر می شود 6-2بعد از اجرای دستور بالا پنجره ی شکل ) (1

 

 

 

 

 

 

 

 

 تعیین درجات آزادی سازه:

   منوی… Analyze > Set Active Degrees of Freedom: دستور مقابل را اجرا می کنیم (1

 ( نمایش داده می شود.6-4با اجرای دستور بالا پنجره ی شکل ) (1

 

 

 

 

 

 

 

 

 کنترل سازه از نظر ترسیمات:

 منوی…Analyze > Check Model: دستور مقابل را اجرا می کنیم (1

 کل تیک ها را فعال می کنیم. ( نمایش داده می شود.6-2اجرای دستور بالا پنجره ی شکل )با  (0
 

 

اختلاف نظر بسیاری  P-Deltaدر انتخاب ترکیب بار 

وجود دارد بعضی از طراحان بر این باورند که بار مرده 

و زنده  بدون ضریب هستند  ولی درمقابل بعضی از 

 P-Deltaطراحان ترکیب بار اول را به عنوان ترکیب بار 

 در نظر می گیریم 

 6-1شکل 

 
 6-1شکل 

روی این آیکون کلیک می کنیم 

 تا تمامی درجات آزادی فعال شود.
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 تحلیل سازه:

 منوی…Analyze > Set Load Cases to Run: دستور مقابل را اجرا می کنیم (1

 ( نمایش داده می شود. 6-6اجرای دستور بالا پنجره ی شکل )با  (0

 

 

 

 

 

 

 

 

 منوی… Analyze > Run Analyzeسپس دستور مقابل را اجرا می کنیم :  (2

 

 

 6-1شکل 

 6-6شکل 

 (No Warning) خطایی وجود نداردچون در ترسیم های ما 

 اگه وجود داشته باشد خطا هایی را در بالا نشان می داد

 

 6-6شکل 

 برای محاسبه مرکز سختی

برای اینکه محاسبات نرم افزار 

 در مانیتور نمایش داده شود
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 (6-0بعد از اینکار نرم افزار شروع به تحلیل سازه میکند مانند شکل ) (4

 

 

 

 

 

 

 

 

 

 

 

 فصل هفتم:

 نمایش بار های وارد برسازه: 

 منوی…Display > Load Assigns > Frame or Joint or Shell: کنیمدستور مقابل را اجرا می  (1

 ( نمایش داده می شود.6-2بعد پنجره ی شکل ) (0

 

 

 

 

 ( نمایش داده می شود.6-2شکل ) OKبعد 

 

 

 

 6-7شکل 

 سطحیبار  بار نقطه ای بار خطی

 

نو ع بار را در این جا مشخص  میکنیم و 

 را می زنیم OKبعد 

 6-8شکل 
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 برش ، نیروی محوری و پیچشی:نمایش لنگر ، 

 اجرا می کنیم منوی Display > Force / Stress Diagrams > Frame / Pier / Spandrel /Link Forcesدستور:  (0
 ( نمایش داده می شود.6-02سپس پنجره ی شکل ) (0

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 6-9شکل 

 

 نمایش لنگر خمشی 

  نیروی برشینمایش 

  یپیچشنمایش لنگر 

  نیروی محورینمایش 

براساس ترکیب بار یا حالت بار یا مود 

 ارتعاشی نیرو ها را نشان دهد

  برای بزرگنمایی نمودار ها است

  نحوه ی نمایش نمودارهای نیرو

 6-12شکل 
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 ی آن را مشاهد ه کنیم.بعد از اجرای دستور بالا می توانیم بر روی هر یک از اعضا کلیک کرده تا دیاگرام نیرو ها 

 فصل هفتم:

 تنظمیات طراحی:

 اجرا می کنیم منوی Design > Concrete Frame Design > View / Revise Preferencesدستور:  (0
 ( نمایش داده می شود.0-0سپس پنجره ی شکل ) (0

 .نرم افزار مورد قبول استچون ما ترکیب بارهای دستی استفاده کرده ایم نیازی به تغییر مقادیر نیست و پیش فرض 

 

 

 

 

 

 

 

 

 

 تعیین ترکیب های  بار طراحی:

 اجرا می کنیم منوی …Design > Concrete Frame Design > Select Design Combinationsدستور:  (0
 ( نمایش داده می شود.0-0سپس پنجره ی شکل ) (0

 

 

 

 

 

 

 
 7-1شکل 

 

ترکیب بارهای دستی را انتخاب کرده و سپس به 

 انتقال می دهیم Design Combinationdلیست 

 7-1شکل 
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 تعیین شکل پذیری سازه:

 .را انتخاب کنیم  (Moderateسازه ما چون قاب خمشی با شکل پذیری متوسط است باید گزینه )

 همه سازه را انتخاب می کنیم Ctrl + Aابتدا با کلید ترکیبی  (0
 اجرا می کنیم منوی …Design > Concrete Frame Design > View / Revise Overwriteسپس دستور:  (0
 ( نمایش داده می شود.0-2سپس پنجره ی شکل ) (2

 

 

 

 

 

 

 

 

 

 

 عملیات طراحی:

 برای طراحی اعضا باید مراحل زیر را انجام دهیم:

 را اجرا می کنیم. Design > Concrete Frame Design > Start Design /Checkدستور :  (0

 اطلاعات بعد از طراحی:

 را اجرا می کنیم.Design > Concrete Frame Design > Display Design infoدستور :  (0
منوی کرکره ای وجود دارد که در جدول زیر همه  Design Outoptباز میشود که در مقابل گزینه   (0-4پنجره ی شکل ) (0

 آن ها به اختصار توضیح داده شده است.

 

 

 

 

 
 7-1شکل 

http://www.omraniha.com


 نویسنده:سعید مرتضوی                                                                ETABS2015 آموزش نرم افزار

 

 

 

 

 

http://www.omraniha.com

